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What’s New in this Guide
•

General improvements for enhanced functionality.
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About Content Manager
DocAve Content Manager for SharePoint 2010/SharePoint 2013/SharePoint 2016 provides
administrators with the ability to comprehensively move, copy, and restructure SharePoint sites,
Apps for SharePoint, content, and topology within or across SharePoint on-premises and online
environments. Through a centralized, highly intuitive management console, featuring familiar
ribbon-based controls and wizard-based, step-by-step guidance, administrators can seamlessly
manage and restructure SharePoint content with minimal interruption to business processes in
order to quickly respond to evolving information governance requirements.
*Note: AvePoint is not responsible for any circumvention of a SharePoint app’s license that may
occur from moving an app from one site collection to another or one farm to another. It is the
customer’s responsibility to ensure that all licenses for the app have been purchased and
deployed properly.
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Complementary Products
Many products and product suites on the DocAve 6 platform work in conjunction with one
another. The following products are recommended for use with Content Manager:
•

DocAve Connector for collaborating upon network file shares and cloud storage
resources directly through SharePoint without migration. Connected content
appears as normal SharePoint content, and can be leveraged exactly as if it were
residing within a SharePoint document library.

•

DocAve Replicator for SharePoint for copying SharePoint content within the
same SharePoint farm or from one SharePoint farm to another.

•

DocAve Report Center for SharePoint to examine pain points in the SharePoint
infrastructure and report on SharePoint user behavior and changes.

•

DocAve Data Protection for setting backup and recovery points prior to
adjusting SharePoint governance policies in this product.
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Submitting Documentation Feedback to AvePoint
AvePoint encourages customers to provide feedback regarding our product documentation. You
can Submit Your Feedback on our website.
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Before You Begin
Refer to the sections to review the system requirements for DocAve Content Manager.

AvePoint’s Testing Policy and Environment Support
Supported Software Environments
AvePoint is committed to testing against all major versions and service packs of SharePoint as
well as the latest versions of Windows Server and SQL Server, as Microsoft announces support
and compatibility.
*Note: AvePoint does not recommend or support installing DocAve on client operating systems.

Supported Hardware
AvePoint is committed to maintaining a hardware agnostic platform to ensure that DocAve
operates on common Windows file sharing and virtualization platforms. To ensure that DocAve
is hardware agnostic, AvePoint tests hardware that is intended to support SharePoint and
DocAve infrastructure, storage targets, and hardware-based backup and recovery solutions, as
supported by AvePoint’s partnerships. AvePoint directly integrates with the following platforms:
any Net Share, FTP, Amazon S3, AT&T Synaptic, Box, Caringo Storage, Cleversafe, DELL DX
Storage, Dropbox, EMC Atmos, EMC Centera, Google Drive, HDS Hitachi Content Platform, IBM
Spectrum Scale Object, IBM Storwize Family, Microsoft Azure Storage, NetApp Data ONTAP,
NFS, OneDrive, Rackspace Cloud Files, and TSM.
All other hardware platforms that support UNC addressable storage devices are supported.
*Note: AvePoint has ended the test and development for Caringo Storage and DELL DX Storage
in DocAve since DocAve 6 SP7 CU1, as the providers of these two platforms have stopped the
platform maintenance.
*Note: Due to changes in the IBM Tivoli Storage Manager API, DocAve 6 Service Pack 6 and
later versions require that TSM Client version 7.1.2 is installed on the Control Service and Media
Service servers.
*Note: Most of the hardware partnerships referenced in this guide are intended to make use of
advanced functionality (such as snapshot mirroring, BLOB snapshots, indexing, long-term
storage, WORM storage, etc.), and are not indications that any changes to the product are
required for basic support. In most cases, hardware can be supported with no change to the
product.
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Supported Backup and Recovery
DocAve supports BLOB backup storage according to the list of hardware platforms above. BLOB
snapshot function, however, is currently only supported on OEM versions and NetApp hardware.
DocAve supports SQL content and Application database backups via the SharePoint Volume
Shadow Copy Service (VSS) on all Windows and SQL server platforms listed above. DocAve also
supports snapshot-based SharePoint VSS on all hardware listed above where the hardware
partner has certified support with Microsoft.
DocAve supports application and configuration server backups for all the supported software
environments listed above. DocAve 6 SP5 or later supports VM backup via Hyper-V/VMWare for
the following operating systems: Windows Server 2008 R2, Windows Server 2012, Windows
Server 2012 R2, and Microsoft Hyper–V Server 2012 R2.

Configuration

In order to use Content Manager, the DocAve 6 platform must be installed and configured
properly on your farm.
For instructions on installing the DocAve Platform, DocAve Manager, and DocAve Agents, refer
to the DocAve 6 Installation Guide.

Required Permissions

To install and use Content Manager properly, ensure that the following permissions are met.

Content Manager for SharePoint On-Premises
Before using Content Manager for SharePoint on-premises, ensure that the DocAve Agent
account has the following permissions:
1. Local System Permissions: These permissions are automatically configured by DocAve
during installation. Refer to Local System Permissions for a list of the permissions
automatically configured upon installation. If there are no strict limitations on the
permissions, you can simply add the DocAve Agent account to the local Administrators
group to apply all of the required permissions.
2. SharePoint Permissions: These permissions must be manually configured prior to using
DocAve 6 Content Manager; they are not automatically configured.
•

User is a member of the Farm Administrators group. Since administrator works
across farms and on all SharePoint settings and configurations, this account is
needed in order to provide the most complete quality of service.

•

Full Control to all zones of all Web applications via User Policy for Web
Applications

®
DocAve 6 Content Manager

9

•

Full Control to the User Profile Service
*Note: This permission is required to copy or move My Sites to a destination.

However, to ensure a successful copy or move action on My Site, grant the User
Profile Service that is associated with the destination Web application with Full

Control and Administrator with Full Control permissions to the Application

pool account of the destination Web application.
•

User Profile Service Application permission:
o

o

For SharePoint 2010


Use Personal Features



Create Personal Site



Use Social Features

For SharePoint 2013 and SharePoint 2016


Create Personal Site (required for personal storage, newsfeed, and
followed content)



Follow People and Edit Profile



Use Tags and Notes

•

Managed Metadata Service: Term Store Administrator

•

Search Service: Full Control

•

Business Data Connectivity Service: Full Control

*Note: To deploy apps, the Agent account cannot be a system account.
3. SQL Permissions: These permissions must be manually configured prior to using DocAve
6 Content Manager; they are not automatically configured.
•

•

SharePoint 2010
o

db_owner database role in all of the databases related to SharePoint,
including Content, Configuration, and Central Administration databases.

o

db_owner database role in the User Profile Service database.

o

db_owner database role in the Nintex Workflow databases.

SharePoint 2013
o

SharePoint_Shell_Access database role in all of the databases related to
SharePoint, including Content, Configuration, and Central Administration
databases.
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o

SharePoint_Shell_Access database role and db_rbs_admin database role
in the Content database with Storage Manager or Connector data.

o

db_owner database role in the User Profile Service database, App
Management database, and Nintex Workflow databases.

With SharePoint_Shell_Access database role, Content Manager has some

limitations on copying/moving objects. For more information, see the following

AvePoint Knowledge Base article:

http://www.avepoint.com/community/kb/limitations-for-docave-6-products-ifdocave-agent-account-has-the-sharepoint_shell_access-role. AvePoint

recommends that you assign the db_owner role to DocAve Agent account.
*Note: The SharePoint_Shell_Access role can only be assigned via SharePoint
2013 Management Shell. For instructions on how to assign this role to a user,

refer to the following Microsoft technical article: https://technet.microsoft.com/enus/library/ff607596.aspx.
•

SharePoint 2016
o

db_owner database role in all of the databases related to SharePoint,
including Content, Configuration, and Central Administration database.

o

db_owner database role in the User Profile Service database.

o

db_owner database role in the App Management databases.

o

db_owner database role in the Nintex Workflow databases.

If a Web application enables the forms-based authentication and uses the database as

the method of forms-based authentication, ensure at least one condition:
•

The Agent account has the db_owner database role in the FBA database.

•

Select a user in the connectionString node in this Web application’s web.config
profile that has the access to the FBA database.

Local System Permissions
Some local system permissions are automatically configured during DocAve 6 installation. The
user will be set up as a member of the following local groups:
•

IIS WPG (for IIS 6.0) or IIS IUSRS (for IIS 7.0)

•

Performance Monitor Users

•

DocAve Users (this group is created by DocAve automatically with the following
permissions):
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o

Full Control to the Registry of
HKEY_LOCAL_MACHINE\SOFTWARE\AvePoint\DocAve6

o

Full Control to the Registry of
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\EventLog

o

Full Control to the Communication Certificate

o

o

Permission of Log on as a batch job (navigate to: Control Panel >
Administrative Tools > Local Security Policy > Security Settings > Local
Policies > User Rights Assignment)
Full Control to the DocAve Agent installation directory

Content Manager for SharePoint Online
Before using Content Manager for SharePoint Online, ensure that you meet the following
prerequisites:
•

You have purchased the corresponding license for Content Manager for
SharePoint Online.

•

You have created the SharePoint Sites Group in Control Panel and added one or
more SharePoint on-premises or SharePoint Online site collections to the group.
For more information, refer to the Control Panel Reference Guide.

Registered SharePoint On-Premises Site Collection
The following permissions are required for Content Manager to manage registered SharePoint
on-premises site collections.
Local System Permissions for DocAve Agent Account
To install and use Content Manager properly, ensure that the DocAve Agent account has the
proper Local System Permissions.
DocAve automatically configures some permissions during installation. Refer to Local System
Permissions for more details. If there are no strict limitations on the permissions, you can simply
add the DocAve Agent Account to the local Administrators group to apply all of the required
permissions.
Required Permissions for the Account Used to Register the SharePoint On-Premises Site
Collections
The account that is used to register SharePoint on-premises site collections in Control Panel >
Manual Object Registration > Manage Objects must have the following permissions to each
site collection:
•

A member of the Site Collection Administrator group.

•

User Profile Service Application:
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o

User Profile Connection Permission: Full Control

o

User Profile Administrator

o

Create Personal Site (required for personal storage, newsfeed, and
followed content)

o

Follow People and Edit Profile

o

Use Tags and Notes

•

Managed Metadata Service: Term Store Administrator

•

The Read permission to the Apps for SharePoint library in the App Catalog Site
Collection

The account that is used to register SharePoint on-premises site collections in Control Panel >
Manual Object Registration > Scan must have the following permissions:
•

Full Control permission to all zones of all Web applications via User Policy for
Web Applications.

•

Member has a Database Role of db_owner for all of the databases related to
SharePoint, including Content Databases, SharePoint Configuration Database,
and Central Admin Database.

•

User Profile Service Application:
o

User Profile Connection Permission: Full Control

o

User Profile Administrator

o

Create Personal Site (required for personal storage, newsfeed, and
followed content)

o

Follow People and Edit Profile

o

Use Tags and Notes

•

Managed Metadata Service: Term Store Administrator

•

The Read permission to the Apps for SharePoint library in the App Catalog Site
Collection

Registered SharePoint Online Site Collections
The following permissions are required for Content Manager to manage registered SharePoint
Online site collections.
Local System Permissions for DocAve Agent Account
To install and use Content Manager properly, ensure that the Agent account has the proper
Local System Permissions.
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DocAve automatically configures some permissions during installation. Refer to Local System
Permissions for more details. If there are no strict limitations on the permissions, you can simply
add the DocAve Agent Account to the local Administrators group to apply all of the required
permissions.
Required Permissions for the Account Used to Register Office 365 Objects
The required permissions for the Office 365 account that is used to register Office 365 objects
via Control Panel, vary with registration methods and object types. Refer to the tables below for
the details.
Method: Scan Office 365 Objects via Manual Object Registration/Dynamic Object
Registration
Object Type

Office 365 Account
Role

Other Permissions

SharePoint Online
Site Collection

SharePoint
Administrator

•

Managed Metadata Service: Term
Store Administrator

OneDrive for
Business

Global Administrator

•

Permissions for User Profile Service:

Office 365 Group
Team Site

SharePoint
Administrator

•

•

Create Personal Site
(required for personal
storage, newsfeed, and
followed content)

•

Follow People and Edit
Profile

•

Use Tags and Notes

The Add and Customize Pages
permission*

Method: Manually Add Office 365 Objects via Manual Object Registration > Manage
Containers
Object Type

Permissions

SharePoint Online Site
Collection

1. A member of the Site Collection Administrator
group.

OneDrive for Business

2. Permissions for User Profile:

Office 365 Group Team Site
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Method: Manually Add Office 365 Objects via Manual Object Registration > Manage
Containers
•

Follow People and Edit Profile

•

Use Tags and Notes

3. Managed Metadata Service: Term Store
Administrator
4. The Add and Customize Pages permission*
*Note: To copy/move SharePoint Online objects, the Add and Customize Pages permission is
required. Users with the role of SharePoint Administrator or Site Collection Administrator have
the Add and Customize Pages permission, but you must select Allow users to run custom
script on personal sites and Allow users to run custom script on self-service created sites in
SharePoint admin center > settings > Custom Script to enable the permission to these users.
Note that the changes will take effect 24 hours after being set.

Health Analyzer

AvePoint recommends using Health Analyzer to check the prerequisites you need to correctly
use DocAve Content Manager.
*Note: Only the users in the DocAve Administrators group can use Health Analyzer.
*Note: For the rule Agent Account Cannot be SharePoint System Account, you can ignore
the result of this rule if you are not going to deploy apps on the specific Web applications.
For more information about Health Analyzer, refer to the DocAve 6 Installation Guide.
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Getting Started
Refer to the sections below for important information on getting started with Content Manager.
*Note: When logging into DocAve Manager and operating the Content Manager module using
the users in the System groups, the users can only operate the:
•

Farms to which it has permission.

•

Functions to which it has permission.

•

DocAve objects (such as, plans, jobs, registered SharePoint sites, and so on) to
which it has permission.

Administrators or the users in the System groups can grant different permission levels to
different farms. For more information on permission control of users in the System group, refer
to the Control Panel Reference Guide.

Launching Content Manager

To launch Content Manager and access its functionality, complete the following steps:
1. Click the DocAve tab to display all product suites for DocAve 6.
2. Click Administration to access the Administration modules.
3. Click Content Manager to launch this module.

Figure 1: DocAve module launch window.
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Navigating DocAve

DocAve mimics the look and feel of many Windows products, making for an intuitive and
familiar working environment. While there are many windows, pop-up displays, and messages
within DocAve products, they share similar features and are navigated in the same ways.
Below is a sample window in DocAve. It features a familiar, dynamic ribbon, and a searchable,
content list view.

Figure 2: Navigating DocAve.

1. Ribbon Tabs— Allows users to navigate to the DocAve Welcome page and within the
active module.
2. Ribbon Panes – Allows users to access the functionality of the active DocAve module.
3. Manage columns ( ) – Allows users to manage which columns are displayed in the list.
Click the manage columns ( ) button, and then select the checkbox next to the column
name in the drop-down list.
4. Filter the column ( ) – Allows users to filter the information in the List View. Click the
filter the column ( ) button next to the column and then select the checkbox next to the
column name.
5. Hide the column ( ) – Allows users to hide the selected column.
6. Search – Allows users to search the List View pane for a keyword or phrase. You can
select Search all pages or Search current page to define the search scope.
*Note: The search function is not case sensitive.
7. Management Pane – Displays the actionable content of the DocAve module.
®
DocAve 6 Content Manager

17

Content Manager Interface

The Content Manager user interface is made up of the following four main areas:
1. Tabs – Navigate between the different tabs of Content Manager.
2. Ribbon – Toolbar where you can perform actions, configure settings, and access Job
Monitor for Content Manager jobs.
3. Source pane – Access the SharePoint objects at different levels of your farms with
content that you want to copy or move.
4. Destination pane – Access the SharePoint objects at different levels of your farms with
content that you want to copy or move.

Figure 3: Content Manager Interface.
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Basic Content Management Functions
While Content Manager allows you to create plans so that you can repeatedly copy and/or
move jobs without having to reconfigure the settings each time, you can also perform these
simple tasks without having to create an entire plan.
•

Copy – When Content Manager runs a copy job, SharePoint content,
configurations, and securities are copied from the source nodes to the
destination node based on the settings you configured in Default Copy
Settings.

•

Move – When Content Manager runs a move job, SharePoint content,
configurations, and securities are copied from the source nodes to the
destination node based on the settings you configured in Default Move
Settings. The source node content and securities are then deleted. The deletion
of the source content and securities can be configured to occur automatically
after the Move job is complete, or you may choose to manually delete the
content.
*Note: Only the items that are successfully migrated to the destination within

lists are deleted in the source node content. The securities of the container level

objects (e.g. Web application, site collection, site, list, and folder) are not deleted.
•

Create Container – Content Manager allows you to create containers within
SharePoint without having to leave the DocAve interface. The Create Container
feature is useful in cases where you want to copy or move content from the
source nodes to a new destination node without having to pre-create the
destination node within SharePoint.

*Note: If you select the Include New checkbox in the Source pane, content created after the
plan is saved will be included when the plan is executed.
*Note: If you select My Site in the Source pane, use the SP2013CMCustomURLMapping.xml
file to map the URL of the content that the user follows in the personal site to the designated
address of the linked content. Complete the following steps to modify the file for the URL
mappings:
1. Go to the server where your destination DocAve Agent resides. Navigate to
…\AvePoint\DocAve6\Agent\data\SP2013\ContentManager directory.
2. Open the SP2013CMCustomURLMapping.xml file with Notepad, and the following
nodes will appear:
<CustomUrlMappings>
<UrlMapping Source="" Destination=""/>
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</CustomUrlMapping>
3. Enter the original URL of the content that the user follows as the value of the Source
attribute and the designated URL you are about to map as the value of the Destination
attribute.
*Note: If desired, you can add multiple <Url Source="SourceUrl"

Destination="DestinationUrl"/> nodes to map more URLs of the linked content to the
designated ones.

4. Save your configurations and close the file.
After the Content Manager job is finished, the URLs of the content that the user follows
are successfully mapped to the designated destination addresses of the linked content.
*Note: If the following conditions are met, automatic mappings will be performed on
objects within a site, according to relative URLs.

a. A source site URL is mapped to a destination site URL in the
SP2013CMCustomURLMapping.xml file.

b. The URLs of objects within the source site are not manually mapped to
designated URLs in the SP2013CMCustomURLMapping.xml file.

For example, if the site URL http://SourceWebApp/SourceUrlMappingSite is manually
mapped to the site URL http://DestWebApp/DestUrlMappingSite. The document URL
http://SourceWebApp/SourceUrlMappingSite/SourceLib/document.doc will be

automatically mapped to the document URL

http://DestWebApp/DestUrlMappingSite/SourceLib/document.doc.
*Note: When selecting My Site in the Source pane, make sure that the application pool account
of the destination Web application meets the following conditions:
•

Is the Administrator of the User Profile Service currently in use.

•

Has Full Control permission to the User Profile Service currently in use.

*Note: You can control whether to update the URL that is linked to an object and whether to
update the URL of an object after the object is moved to a new destination within the same site
collection by completing the following steps:
1. Log into each DocAve Agent server.
2. Go to the ...\AvePoint\DocAve6\Agent\data\SP2010\ContentManager directory.
3. Open the SP2010CMConfiguration.xml file using Notepad.
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4. There are two nodes to control the update of URL:
•

Locate the <ReplaceBackwardLinksInSameSite value="false"/> node. If
modifying its value to true, the URL that is linked to an object will be updated to
the new one after the source object is moved to a new location within the same
site collection and the source content is deleted.

•

Locate the <ReplaceForwardLinksInSameSite value="true"/> node. If keeping
its value as true, the URL that is added to an object will be updated when the
object is copied or moved to a new location within the same site collection.

5. Save the changes and close the file.
*Note: You can download the job details and related logs in Job Monitor. For more
information, refer to Job Monitor Reference Guide.

Copying Content

The following two sections explain how to configure Default Copy Settings and how to
perform a simple copy of content. Use the Default Copy Settings to customize a template for
your copy settings. These settings will be applied to any new copy jobs you create. You will be
able to edit these settings. To configure the default copy settings, complete the following steps:
1. In the Home tab of the Content Manager interface, click Copy on the ribbon.
2. Select Default Copy Settings from the drop-down menu. The Default Copy Settings
tab appears.
To edit the configured default copy settings before running a copy job, complete the following
steps:
1. In the Home tab of the Content Manager interface, click Online Content Manager on
the ribbon.
2. Select the source and destination nodes on the corresponding trees.
3. Click Copy on the ribbon, and select Copy from the drop-down menu. The Copy tab
appears.
4. Click Edit on the ribbon. The Edit Copy Settings interface appears.
*Note: You can only modify the settings supported by the selected source and destination
nodes in the Edit Copy Settings interface.
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Configuring Default Copy Settings
In the Default Copy Settings tab or the Edit Copy Settings interface under the Copy tab, make
your settings selections in the following fields:
1. Action – Select Attach to transfer the source node as a child node underneath the
destination node, or select Merge to add the content, securities, and configurations of
the source node to the destination node.
2. Promote Method – Choose to promote only the top-level site to the site collection or
promote all of the selected sites to site collections.
This section only appears when satisfying all of the following conditions:
•

In the Default Copy Settings tab, select Merge as the Action option.

•

Select the site collection level or site level nodes in the source tree, and select the
Web application node in the destination tree. Click Copy > Copy on the ribbon,
and click Edit. In the Edit Copy Settings interface under the Copy tab, select
Merge as the Action option.
*Note: When you select the site collection level nodes as the source, only the
Promote all sites to site collections option is available.

3. Which managed path would you like to use in the destination? –Select the Change
the managed path in destination checkbox to configure the managed path you are
about to use in the destination by entering the desired value in the Enter an existing
Wildcard Inclusion Managed Path text box.
This section only appears when satisfying all of the following conditions:
•

In the Default Copy Settings tab, select Merge as the Action option.

•

Select the site collection level or site level nodes in the source tree, and select the
Web application node in the destination tree. Click Copy > Copy on the ribbon,
and click Edit. In the Edit Copy Settings interface under the Copy tab, select
Merge as the Action option.

4. Filter Policy – Select a filter policy from the drop-down list, or click New Filter Policy
from the drop-down list. Filter policies allow you to select specific objects or data within
each SharePoint level from site collection down to the item level. For information on
creating a filter policy, see the DocAve 6 Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not
supported. Exceptions will be recorded in the job report.
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5. Configuration – Choose if you want to migrate configurations to the destination:
•

Select the Copy configuration checkbox to copy the properties, descriptions,
titles, settings, and features from the source node to the destination node. If you
want to keep the look and feel of the source site including the quick launch, top
link bar, navigation, site theme, and master page, select the Keep look and feel
checkbox.
*Note: The Keep look and feel function will only take effect when the followings
are in place:
o

The source node is a site and the destination node is a top-level site or a
site collection.

o

Merge is selected as the action to take in the Action field.

Click Advanced and select the configurations that you want to copy:
o
o

Site Collection Level – Site collection features and properties.
Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts,
page layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you cannot

deselect the checkboxes of the Site features and properties, Navigation

and quick launch, and Web parts, page layout, master pages and
other hidden lists.

o

List Level – List settings, Public views, and List alerts.
*Note: The item alert (including folder alerts, document alerts, and item

alerts) is controlled by the <RestoreItemAlerts value="True" /> node in
the SP2010CMConfiguration.xml file under the following directory of
the destination DocAve Agent server:

\AvePoint\DocAve6\Agent\data\SP2010\ContentManager. The SharePoint
version in this path will differ according to your destination SharePoint
version.

*Note: In the Edit Copy Settings interface, the visibility of Site Collection Level,

Site Level, and List Level will change according to the selected Source node and

Destination node.
•

Leave the Copy configuration checkbox deselected if you do not want to
migrate configuration to the destination. Then, choose from the following
options:
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o

o

Select Copy the item-dependent columns and content types to
maintain item integrity. Then, select a conflict resolution method for
these items’ columns and content types from the drop-down list:


Do not copy/move the columns and content types, or the
corresponding items – Ignores the conflicting columns, content
types, and corresponding items, and do nothing on the source and
destination nodes.



Overwrite the columns and content types – Overwrites the
destination columns and content types with the source node.



Append the columns and content types to destination – Keeps
the destination columns and content types when there is a
conflict. In addition, copies the source columns and content types
to the destination node with a numerical suffix added (for
example, ColumnName_1, ColumnName_2, etc.).

Select Do not copy the item-dependent columns or content types.
Report the items if the corresponding column or content type is not
found in destination. The corresponding items are not copied to the
destination. The job report will show items if the corresponding column or
content type is not found in the destination node.

6. Security – Select the Copy security checkbox if you want to copy the user and/or group
permissions from the source node to the destination node, including SharePoint
permission level and permission inheritance of SharePoint objects. Additionally, select
the Exclude user/group without permission checkbox if you want to exclude users
and/or groups that do not have permissions.
*Note: The definition of users or groups without permission varies with the selected
source node:
•

If the source node is a site collection, the users or groups that meet the following
two conditions are the users or groups without permissions:
o

Users or groups that exist in the source node, but are not Site Collection
Administrators.

o

Users or groups that exist in the source node, but have no permissions to
the top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site

collection are handled individually, and you can refer to the definition above.
•

If the source node is a site, users or groups without permissions refer to the users
or groups that exist in the source node, but have no permissions to this site.
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•

If the source node is an object whose level is lower than the site level, users or
groups without permissions refer to the users or groups that exist in the source
node, but have no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]

Members page of a site, but you can view them in the People and Groups – All People

page. To go to the People and Groups – All People page, modify the value of

MembershipGroupId in the URL of the People and Groups – [SiteName] Members

page to MembershipGroupId=0, then you are brought to the People and Groups – All

People page.

7. Content – Select the Copy content checkbox if you want to copy content in the libraries,
folders, and items from the source node to the destination node. Select Include list
attachment if you want to also copy the attached content in lists.
8. User Profile – Select the Copy user profile checkbox if you want to copy user profiles
from the source node to the destination node.
*Note: This function will only take effect when the source node level is equal to or higher

than the site collection level because users are saved in the top-level site.

9. Workflow – Select the Include workflow definition checkbox to copy the definition of
existing workflows for the selected content from the source node to the destination
node. Select the Include workflow instance to copy the state, history, and tasks of
existing workflows for the selected content. By default, the Include completed instance
checkbox is selected to copy the completed instance. You can select the Include
running instance checkbox if you want to copy the currently running instance in the
source node to the destination node, and then select one of the following options:
•

Cancel workflows – Cancel the copied or moved running workflow in the
destination node after the Content Manager jobs.

•

Restart workflows – Restart the copied or moved running workflow in the
destination node after the Content Manger jobs.

*Note: Content Manager does not support the workflow instances associated with
checked-out files.

10. Managed Metadata Service Setting – Select the Copy Managed Metadata Term Sets
or Terms associated with this content checkbox if you want to copy the associated
term sets or the terms and their parent term sets associated with the content from the
source node to the destination node, and then select one of the following options:
•

Term – Copy terms that are used in the source, their parent terms, the term sets
where the used terms reside, and the names of the groups where the used terms
reside to the destination.
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•

Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to
the destination.

*Note: By default, Content Manager does not support copying a Managed Metadata
Service. However, Content Manager supports it after modifying the

<IsBackupManagedMetadataServiceLevel value="False" /> node in the

SP2010CMConfiguration.xml file under the following directory of the destination

DocAve Agent server: \AvePoint\DocAve6\Agent\data\SP2010\ContentManager.

*Note: You can also copy a Managed Metadata Service by configuring a shared service

mapping using DocAve Deployment Manager. For more information, refer to the

Mapping Settings for Shared Service section in the DocAve 6 Deployment Manager
User Guide.

11. Preserve the Null Column Values – Select Yes to preserve the null values of item
columns (such as newly created columns), or select No to replace null values with default
values in the destination node.
12. Folder Structure Management – Choose if you want to collapse the folder structure of
the copied or moved content. Select the Collapse Folder Structure checkbox to enable
this feature. DocAve also allows you to add a column to the destination for displaying
the source folder path or parent folder name. Select the Add a column to display the
source folder path or parent folder name checkbox to enable this feature as well.
•

Column to display the source folder path – Enter a column name in the text
box to add a Single Line of Text column to display the source folder path.

•

Column to display the parent folder name – Enter a column name in the text
box to add a Single Line of Text column to display the source parent folder
name.

13. Data Compression – Select the Compression checkbox if you want to compress the
data when it is copied. If you choose to compress the data, use the slider to select the
compression rate. Fastest compression rates results in a larger data sets. Lower
compression rates creates smaller better quality data sets, however the compression
takes more time to perform.
*Note: Smaller data sets take longer to backup and recover.
14. Column Mapping – Maps source columns to the configured columns in the destination,
or change the column name to another one. The specified source columns will be
mapped according to the selected column type, and the column values will be mapped
according to the added value mappings. The column can also be changed to Managed
Metadata or Lookup. Select a column mapping from the drop-down list, or click New
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Column Mapping. For information on creating a column mapping, see the DocAve 6
Control Panel Reference Guide.
*Note: If you select the column type Change to Lookup while setting up your column

mapping, make sure that the Lookup column can only be associated with the list or list
column that exists in the destination.

15. Content Type Mapping –Select a content type mapping from the drop-down list, or
click New Content Type Mapping. For information on creating a content type mapping,
see the DocAve 6 Control Panel Reference Guide.
16. Template Mapping – Replaces site and list templates. By inputting or selecting a
template ID, the source template is changed to the destination template. Select a
template mapping from the drop-down list, or click New Template Mapping. For
information on creating a template mapping, see the DocAve 6 Control Panel Reference
Guide.
17. User Mapping – Maps a source user to a target user. If the same user has a different
username in Domain A than in Domain B, or if you want to copy an individual user’s
content, permissions, and metadata in Domain A to another user in Domain B, the user’s
permissions and metadata will not be lost when content is moved. Select a user mapping
from the drop-down list, or click New User Mapping. For information on creating a user
mapping, see the DocAve 6 Control Panel Reference Guide.
18. Domain Mapping – Maps a source domain to a destination domain. The source domain
name will be replaced by the configured destination domain name, and the user in the
source domain will be mapped to the destination user with the same login name. Select
a domain mapping from the drop-down list, or click New Domain Mapping. For
information on creating a domain mapping, see the DocAve 6 Control Panel Reference
Guide.
19. Language Mapping – Displays the destination node in a different language than the
source node after the plan has been executed. Select a language mapping from the
drop-down list, or click New Language Mapping. For information on creating a
language mapping, see the DocAve 6 Control Panel Reference Guide.
20. List Name Mapping – Changes the existing source lists of the copied or moved objects
to your designated lists in the destination. Select a list name mapping from the dropdown list, or click New List Name Mapping. For information on creating a list name
mapping, see the DocAve 6 Control Panel Reference Guide.
21. Backup Environment Before Running Plan – Select the Backup the destination
environment checkbox if you want to create a copy of the destination node prior to
performing the copy. If you choose to back up the destination environment before
performing a copy, you must designate a storage policy. Select the Backup the
destination environment checkbox. The Storage policy drop-down list appears. Select
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a storage policy from the drop-down list or click New Storage Policy to create a new
one.
*Note: Content Manager only supports the Backup type storage policy for the retention

rule. For more information on storage policies, see the DocAve 6 Control Panel Reference
Guide.

22. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level
conflict resolution drop-down list. Select the Check lower objects checkbox if you
want to configure content level conflict resolution, then choose Skip, Overwrite,
Overwrite by Last Modified Time, or Append from the Content level conflict
resolution drop-down list. For detailed information on how Content Manager resolves
conflicts based on these configurations, see Appendix A: Conflict Resolution.
23. Apps Conflict Resolution – Choose Skip, Update App Only, or Replace App and
AppData from the Apps conflict resolution drop-down list. For detailed information on
how Content Manager resolves apps conflicts based on these configurations, see Apps
Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
24. Notification – Select a notification profile from the drop-down list. Click View beside
the drop-down list to view details of the notification profile, or click New Notification
Profile. For information on creating a notification profile, see the DocAve 6 Control
Panel Reference Guide.
In the Default Copy Settings tab, click Save to save these configurations and return to the
Home tab of Content Manager, or click Cancel.

Performing a Simple Copy
To perform a simple copy in Content Manager, select the node you want to copy from the
Source pane, and select the desired destination node from the Destination pane. You can use
Advanced Search functionality in the source and destination trees. For more information, refer
to Using Advanced Search in the Source and Destination Trees.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a
site with 2010 experience version, it can only be copied to the site with the same experience
version.
*Note: If the Record Declaration Settings in the destination node conflict with the Record
Declaration Settings in the source node, by default the Record Declaration Settings in the
destination node will be overwritten by the source node settings.
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Click Copy on the ribbon, and then select Copy from the drop-down list. You will be brought to
the Copy tab. The Copy tab provides the following tools:
•

View – Click View on the ribbon if you want to review the copy settings.
*Note: If the selected source nodes or destination node is in the SharePoint onpremises environment, the Agent Group setting appears in the View tab. The

Agent group in the SharePoint on-premises environment will be loaded as the

corresponding Agent group to execute the simple copy.
•

Edit – Click Edit on the ribbon to make changes to the settings. You will be
brought to the Edit Copy Settings page. To configure the settings, refer to
Configuring Default Copy Settings.

•

Preview – Click Preview on the ribbon to see what the data tree of the
destination node will look like after the job is run. The source node is marked by
a prompt message: From Source.
*Note: This function supports Web application, site collection, and site level

objects.
•

Run Now – Click Run Now on the ribbon. Your copy job will begin immediately,
and you will be brought back to the Home tab of Content Manager.

•

Cancel – Click Cancel on the ribbon to close the Copy tab without running the
Copy job.

Moving Content

The following two sections explain how to configure Default Move Settings and perform a
simple move of content.
Use the Default Move Settings feature to customize a template for your move settings. These
settings will be applied to any new move jobs you create. You will be able to edit these settings
before running the move job. To configure default move settings, complete the following steps:
1. In the Home tab of the Content Manager interface, click Move on the ribbon.
2. Select Default Move Settings from the drop-down menu. The Default Move Settings
tab appears.
To edit the configured default move settings, complete the following steps:
1. In the Home tab of the Content Manager interface, click Online Content Manager on
the ribbon.
2. Select the source and destination nodes on the corresponding trees.
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3. Click Move on the ribbon and select Move from the drop-down menu. The Move tab
appears.
4. Click Edit on the ribbon to edit the default move settings. The Edit Move Settings
interface appears.
*Note: Before running a move job, you can only modify the settings supported by the selected
source and destination nodes in the Edit Move Settings interface.

Configuring Default Move Settings
In the Default Move Settings tab or the Edit Move Settings interface under the Move tab,
make your settings selections in the following fields:
1. Action – Select Attach to transfer the source node as a child node underneath the
destination node, or select Merge to add the content, securities, and configurations of
the source node to the destination node.
2. Promote Method – Choose to promote only the top-level site to the site collection or
promote all the selected sites to site collections.
This section only appears when satisfying all of the following conditions:
•

In the Default Move Settings tab, select Merge as the Action option.

•

Select the site collection level or site level nodes in the source tree and select the
Web application node in the destination tree. Click Move > Move on the ribbon
and click Edit. In the Edit Move Settings interface under the Move tab, select
Merge as the Action option.
*Note: When you select the site collection level nodes as the source, only the
Promote all sites to site collections option is available.

3. Which managed path would you like to use in the destination? – Select the Change
the managed path in destination checkbox to configure the managed path you are
about to use by entering the desired value in the Enter an existing Wildcard Inclusion
Managed Path text box.
This section only appears when satisfying all of the following conditions:
•

In the Default Move Settings tab, select Merge as the Action option.

•

Select the site collection level or site level nodes in the source tree and select the
Web application node in the destination tree, Click Move > Move on the ribbon,
and click Edit. In the Edit Move Settings interface under the Move tab, select
Merge as the Action option.

4. Filter Policy – Select a filter policy from the drop-down list or click New Filter Policy.
Filter policies allow you to select specific objects or data within each SharePoint level
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from site collection down to the item level. For information on creating a filter policy, see
the DocAve 6 Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not
supported. Exceptions will be recorded in the job report.

5. Configuration – Choose if you want to migrate the configurations to the destination:
•

Select the Move configuration checkbox to move the properties, descriptions,
titles, settings, and features from the source node to the destination node. If you
want to keep the look and feel of the source site including the quick launch, top
link bar, navigation, site theme, and master page, and then select the Keep look
and feel checkbox.
*Note: The Keep look and feel function will only take effect when the followings

are in place:
o

The source node is a site and the destination node is a top-level site or a
site collection.

o

Merge is selected as the action to take in the Action field.

Click Advanced to select the configurations that you want to move:
o
o

Site Collection Level – Site collection features and properties.
Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts,
page layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you cannot

deselect the checkboxes of the Site features and properties, Navigation

and quick launch, and Web parts, page layout, master pages and
other hidden lists.
o

List Level – List settings, Public views, and List alerts.
*Note: The item alert (including folder alerts, document alerts, and item

alerts) is controlled by the <RestoreItemAlerts value="True" /> node in
the SP2010CMConfiguration.xml file under the following directory of
the destination DocAve Agent server:

\AvePoint\DocAve6\Agent\data\SP2010\ContentManager. The SharePoint

version in this path will differ according to your destination SharePoint
version.
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*Note: In the Edit Move Settings interface, the visibility of Site Collection Level,
Site Level, and List Level will change according to the selected Source node and

Destination node.
•

Leave the Move configuration checkbox deselected if you don’t want to migrate
the configuration to the destination. Then, choose from the following options:
o

o

Select Move the item-dependent columns and content types to
maintain item integrity. Then, select a conflict resolution method for
these items’ columns and content types from the drop-down list:


Do not copy/move the columns and content types, or the
corresponding items – Ignores the conflicting columns, content
types, and the corresponding items, and do nothing on the source
and destination node.



Overwrite the columns and content types – Overwrites the
destination columns and content types with the source node.



Append the columns and content types to destination – Keeps
the destination columns and content types when there is a
conflict. In addition, copies the source columns and content types
to the destination node with a numerical suffix added (for
example, ColumnName_1, ColumnName_2, etc.).

Select Do not move the item-dependent columns or content types.
Report the items if the corresponding column or content type is not
found in destination. The corresponding items are not moved to the
destination. DocAve will report the items if the corresponding column or
content type is not found in the destination node.

6. Security – Select the Move security checkbox to move the user and/or group
permissions from the source node to the destination node, including SharePoint
permission level and permission inheritance of SharePoint objects. Select the Exclude
user/group without permission checkbox to not move users and/or groups that have
no permissions.
*Note: The definition of users or groups without permission varies with the selected
source node:
•

If the source node is a site collection, the users or groups that meet the following
two conditions do not have permissions:
o

Users or groups that exist in the source node but are not Site Collection
Administrators.

o

Users or groups that exist in the source node but have no permissions to
any sites of the site collection.
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*Note: If the source node is a Web application, the permissions of each site

collection are handled individually, and you can refer to the definition above.
•

If the source node is a site, users or groups without permissions refer to the users
or groups that exist in the source node but have no permissions to this site.

•

If the source node is an object whose level is lower than the site level, users or
groups without permissions refer to the users or groups that exist in the source
node but have no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]

Members page of a site, but you can view them in the People and Groups – All People

page. To go to the People and Groups – All People page, modify the value of

MembershipGroupId in the URL of the People and Groups – [SiteName] Members

page to MembershipGroupId=0. You will be brought to the People and Groups – All

People page.

7. Content – Select the Move content checkbox to move content in libraries, folders, and
items from the source node to the destination node. Select the Include list attachment
to also move the attached content in lists.
8. User Profile – Select the Move user profile checkbox to move user profiles from the
source node to the destination node.
9. Workflow – Select the Include workflow definition checkbox to move the definition of
the existing workflows for the selected content and/or select the Include workflow
instance to move the state, history, and tasks of existing workflows for the selected
content. By default, the Include completed instance checkbox is selected to move the
completed instance from the source node to the destination node. You can select the
Include running instance checkbox if you want to move the currently running instance,
and then select one of the following options:
•

Cancel workflows – Cancel the copied or moved running workflow in the
destination node after the Content Manager jobs.

•

Restart workflows – Restart the copied or moved running workflow in the
destination node after the Content Manger jobs.

*Note: Content Manager does not support the workflow instances associated with
checked-out files.

10. Managed Metadata Service Setting – Select the Managed Metadata Term Sets or
Terms associated with this content checkbox if you want to copy the associated term
sets or the terms and their parent term sets associated with the content from the source
node to the destination node, and then select one of the following options:
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•

Term – Copy terms that are used in the source, their parent terms, the term sets
where the used terms reside, and the names of the groups where the used terms
reside to the destination.

•

Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to
the destination.

*Note: By default, Content Manager does not support copying a Managed Metadata
Service. However, Content Manager supports it after modifying the

<IsBackupManagedMetadataServiceLevel value="False" /> node in the

SP2010CMConfiguration.xml file under the following directory of the destination

DocAve Agent server: \AvePoint\DocAve6\Agent\data\SP2010\ContentManager.

*Note: You can also copy a Managed Metadata Service by configuring a shared service
mapping using DocAve Deployment Manager. For more information, refer to the

Mapping Settings for Shared Service section in the DocAve 6 Deployment Manager
User Guide.

11. Preserve the Null Column Values – Select Yes to preserve the null values of item
columns or select No to replace null values with default values in the destination node.
12. Folder Structure Management – Choose if you want to collapse the folder structure of
the copied or moved content. Select the Collapse Folder Structure checkbox to enable
this feature. DocAve also allows you to add a column to the destination for displaying
the source folder path or parent folder name. Select the Add a column to display the
source folder path or parent folder name checkbox to enable this feature as well.
•

Column to display the source folder path – Enter a column name in the text
box to add a Single Line of Text column to display the source folder path.

•

Column to display the parent folder name – Enter a column name in the text
box to add a Single Line of Text column to display the source parent folder
name.

13. Data Compression – Select the Compression checkbox if you want to compress the
data when it is moved. If you choose to compress the data, use the slider to select the
compression rate. Fastest compression rate results in a larger data set. Best compression
rate results in a Slower Compression rates result in smaller, better quality data sets.
*Note: Smaller data sets take longer to backup and recover.
14. Column Mapping – Maps source columns to the configured columns in the destination
or change the column name. The selected source columns will be mapped according to
the selected column type, and the column values will be mapped according to the added
value mappings. The column can also be changed to Managed Metadata or Lookup.
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Select a column mapping from the drop-down list or click New Column Mapping. For
information on creating a column mapping, see the DocAve 6 Control Panel Reference
Guide.
*Note: If you select the column type Change to Lookup while setting up your column

mapping, make sure that the Lookup column can only be associated with the list or list
column that exists in the destination.

15. Content Type Mapping –Select a content type mapping from the drop-down list or
click New Content Type Mapping. For information on creating a content type mapping,
see the DocAve 6 Control Panel Reference Guide.
16. Template Mapping – Replaces site and list templates. By inputting or selecting a
template ID, the source template is changed to the destination template. Select a
template mapping from the drop-down list or click New Template Mapping. For
information on creating a template mapping, see the DocAve 6 Control Panel Reference
Guide.
17. User Mapping – Maps a source user to a target user. If the same user has a different
username in Domain A than in Domain B, or if you want to move an individual user’s
content, permissions, and metadata in Domain A to another user in Domain B, the user’s
permissions and metadata will not be lost when content is moved. Select a user mapping
from the drop-down list or click New User Mapping. For information on creating a user
mapping, see the DocAve 6 Control Panel Reference Guide.
18. Domain Mapping – Maps a source domain to a destination domain. The source domain
name will be replaced by the configured destination domain name, and the user in the
source domain will be mapped to the destination user which has the same login name.
Select a domain mapping from the drop-down list or click New Domain Mapping. For
information on creating a domain mapping, see the DocAve 6 Control Panel Reference
Guide.
19. Language Mapping – Displays the destination node in a different language than source
node after the plan has been executed. Select a language mapping from the drop-down
list or click New Language Mapping. For information on creating a language mapping,
see the DocAve 6 Control Panel Reference Guide.
20. List Name Mapping – Changes the existing source lists of the copied or moved objects
to your designated lists in the destination. Select a list name mapping from the dropdown list or click New List Name Mapping. For information on creating a list name
mapping, see the DocAve 6 Control Panel Reference Guide.
21. Source Deletion Method – Select Manual to delete the source content once the job is
complete. To delete it manually, select the move job in Job Monitor, then click Delete on
the ribbon and select Delete Content from the drop-down list. Select Automatic to
have DocAve delete the source content.

®
DocAve 6 Content Manager

35

22. Delete Source Checked Out Documents – Select Yes to have DocAve delete the
checked-out documents which are not checked out by the Agent account on the source
node when the source content is deleted. By default, No is selected, which means the
checked-out documents that are not checked out by the Agent account will not be
deleted on the source. DocAve will delete the checked-out documents that are checked
out by the Agent account regardless of the selection of Delete Source Checked Out
Documents option when the source content is deleted.
23. Backup Environment Before Running Plan – Select the Backup the source
environment checkbox if you want to create a copy of the source node prior to
performing the move job. If you choose to back up the source and/or destination
environment before performing a move, you must designate a storage policy. Select
storage policy or click New Storage Policy.
*Note: Content Manager only supports the Backup type storage policy for retention rule.
For more information on storage policies, see the DocAve 6 Control Panel Reference
Guide.

*Note: The source node is deleted as the second step in a move job. If Backup the

source environment is not selected, you will not be able to restore the source node to its
state prior to the move job.

24. Conflict Resolution – Choose Skip, Merge or Replace from the Container level
conflict resolution drop-down list. Select the Check lower objects checkbox to
configure content level conflict resolution, then choose Skip, Overwrite, Overwrite by
Last Modified Time, or Append from the Content level conflict resolution drop-down
list. For detailed information on how Content Manager resolves conflicts based on these
configurations, see Appendix A: Conflict Resolution.
25. Apps Conflict Resolution – Choose Skip, Update App Only, or Replace App and
AppData from the Apps conflict resolution drop-down list. For detailed information on
how Content Manager resolves apps conflicts based on these configurations, refer to
Apps Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
26. Notification –Select a notification profile from the drop-down list. Click View beside the
drop-down list to view details of the notification profile or click New Notification
Profile. For information on creating a notification profile, see the DocAve 6 Control
Panel Reference Guide.
27. In the Default Move Settings tab, click Save to save these configurations and return to
the Home tab of Content Manager, or click Cancel.
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Performing a Simple Move
To perform a simple move in Content Manager, select the node you want to move from the
Source pane, and select the destination node from the Destination pane. You can use the
Advanced Search functionality in the source and destination trees. For more information, refer
to Using Advanced Search in the Source and Destination Trees.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a
SharePoint 2010 mode site, it can only be moved to the same mode site.
*Note: If the Record Declaration Settings in the destination node conflict with the Record
Declaration Settings in the source node, by default the Record Declaration Settings in the
destination node will be overwritten by the source node settings. The records that have been
blocked from deletion in the source node will not be deleted after the Move job.
Click Move on the ribbon, and then select Move from the drop-down list. You will be brought
to the Move tab. The Move interface provides the following tools:
•

View – Click View on the ribbon to review your settings.
*Note: If the selected source nodes or destination node is in the SharePoint onpremises environment, the Agent Group setting appears in the View tab. The

Agent group in the SharePoint on-premises environment will be loaded as the
corresponding Agent group to execute the simple move.

•

Edit – Click Edit on the ribbon to make changes to the move settings. You will be
brought to the Edit Move Settings page. To configure the settings in the Edit
Move Settings interface, refer to Configuring Default Move Settings.

•

Preview – Click Preview on the ribbon to see what the data tree of the
destination node will look like after the move job is run. The source node is
marked by a prompt message: From Source.
*Note: The preview function supports Web application, site collection, and site

level objects.
•

Run Now – Click Run Now on the ribbon to execute the move job. Your move
job will begin immediately, and you will be brought back to the Home tab of
Content Manager.

•

Click Cancel on the ribbon to close the Move tab without running the Move job.

Creating Containers

Use the Create Container feature to create containers in SharePoint without leaving the DocAve
interface. This feature allows you to continue performing content management tasks without
®
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having to create all of the necessary containers (site collections, sites, lists, and folders) before
using Content Manager.
*Note: If the destination farm is a FBA or ADFS farm, when manually creating a site collection, a
pop-up window will appear to let you select the administrator of the site collection you are
about to create.
To create a container, enter the name of a new container in the available field in the Destination
pane, and then click Create Container. The Create Container interface appears. Configure the
settings for each type of container according to the following sections.
*Note: When creating a folder, you do not need to configure the settings. When you click
Create Container at the folder level, you will create a folder immediately.

Creating a Site Collection for SharePoint On-Premises
Configure these settings on the Create Container interface:
1. Title and Description – Enter the Title of the new site collection, and an optional
description.
2. Web Site Address – Displays the URL of the site collection you are about to create.
3. Template Selection – Select the desired language from the Select a language dropdown list, and then select a site template for this new site collection. Click on a tab to
access the templates listed in that category or click on the Custom tab and select
<Select Template Later …> to not choose a template upon creation.
4. Primary Site Collection Administrator – Enter the Username of the primary
administrator for this site collection.
5. Secondary Site Collection Administrator – Enter the Username of the secondary
administrator for this site collection.
6. Quota Template – Select the storage quota template to apply to this site collection. To
add a new quota template, click the Manage Quota Templates link. The Manage Quota
Templates interface appears. Configure the following settings:
a. Template Name – Edit an existing quota template or create a new template.
o

Edit an existing template – Select this radio button if you want to edit an
existing quota template. You can only edit the Personal Site here.

o

Create a new quota template – Select this radio button if you want to
create a new quota template.
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Template to start from – Select [New Blank Template] or
Personal Site from the drop-down list.



New template name – Enter a name for the new template.
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b. Storage Limit Values – Choose if you want to limit the amount of storage

available on a site collection. Set the maximum amount of storage and a warning

level. When the warning level or maximum storage level is reached, an email alert
is sent to the site administrators to inform them of the issue.
o

Limit site storage to a maximum of _MB – Enter a positive integer less
than 1 terabyte in the text box.

o

Send warning e-mail when site collection storage reaches _MB – Enter
a positive integer smaller than the entered maximum storage quota.

c. Sandboxed Solutions with Code Limits – Choose if you want sandboxed

solutions with code for this site collection. When the warning level is reached, an
email alert is sent. When the maximum usage limit is reached, sandboxed

solutions with code are disabled for the rest of the day and an email alert is sent
to the site administrator.
o

Limit maximum usage per day to _points – Enter a positive integer less
than 1 million in the text box.

o

Send warning e-mail when usage per day reaches _points – Enter a
positive integer less than or equal to the maximum usage.

d. Click OK to save your configurations and return to the Create Container

interface or click Cancel to return to the Create Container interface without

saving any changes.

7. Content Database – Select the content database for this site collection.
8. Click OK to create the new site collection or click Cancel to close the Create Container
interface.

Creating a Site Collection for SharePoint Online
Configure these settings on the Connection page and the Create Container page:
1. Choose a way to obtain the Office 365 credentials for creating a SharePoint Online site
collection.
•

Use an existing account profile – Use an existing Office 365 account profile to
create a SharePoint Online site collection. This option will be automatically
selected when there are existing Office 365 account profiles in DocAve.
o

o

Select an existing Office 365 account profile from the drop-down menu.
The related Office 365 User ID and SharePoint Admin Center URL will
appear in the corresponding text boxes automatically.
Enter the corresponding password.
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•

Provide the credentials – Enter an Office 365 account for creating a SharePoint
Online site collection. This option will be automatically selected when there is no
existing Office 365 account profile in DocAve.
o

Office 365 User ID – Enter the user ID that will be used to create a
SharePoint Online site collection.
*Note: The user must have the Global administrator role or the
SharePoint administrator role.

o

Password – Enter the password.

o

SharePoint Admin Center URL – Complete the SharePoint admin center
URL.
Select the Save as an authentication profile checkbox to save the

credentials as a new Office 365 account profile. Once this checkbox is

selected, you are required to enter a profile name in the Profile Name
text box.

2. Click Connect. The Create Container page appears where you can configure the
following settings for the SharePoint Online site collection.
•

Title – Enter a name for the new site collection.

•

Web Site Address – Select a domain name and a URL path and enter a URL
name for the site collection.

•

Template Selection – Select a language from the Select a language drop-down
list, and then select a site template for this new site collection. Click on a tab to
access the templates listed in that category or click on the Custom tab and select
<Select Template Later …> to not choose a template during creation.

•

Time Zone – Select the time zone that is appropriate for the location of the site
collection.

•

Administrator – Enter the username of the site collection administrator.

•

Storage Quota – Enter the number of megabytes (MB) you want to allocate to
this site collection.

•

Server Resource Quota – Enter the amount of resources you want to allocate to
the site collection.

3. Click OK to create the new site or click Cancel to close the Create Container interface.

Creating a Site
Configure these settings on the Create Container interface:
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1. Title and Description – Enter the Title of the new site, and an optional description.
2. Web Site Address – Displays the URL of the site you are about to create.
3. Template Selection – Select the desired language from the Select a language dropdown list, and then select a site template for this new site. Click on a tab to access the
templates listed in that category.
4. Permissions – Select Use unique permissions to allow a unique set of users access to
this new site, or select Use same permissions as parent site to allow the same users
who can access the parent site to access this new site.
5. Navigation – Select the Yes or No radio button to determine whether to display this site
on the Quick Launch and the top link bar of the parent site.
6. Navigation Inheritance – Select the Yes or No radio button to determine whether to
use the top link bar from the parent site.
7. Click OK to create the new site or click Cancel to close the Create Container interface.

Creating a List/Library
Configure these settings in the Create Container interface:
1. Object Type – Choose if you want to create a List or a Library.
2. Category – Select the category type for the new list or library from the drop-down list.
3. Navigation – Determine if you want to display this list or library on the Quick Launch.
4. Click OK or click Cancel to close the Create Container interface.

Using Advanced Search in the Source and Destination Trees

If working with a large SharePoint environment, use Advanced Search in the destination tree to
find the desired node by completing the following steps:
In the Source or Destination pane, click the farm name to expand the data tree.
Right-click a farm level node, a Web application level node, the Lists virtual node, the
Sites virtual node, or the Folders virtual node.
Select Advanced Search from the drop-down menu. The Advanced Search interface
appears.
Customize the filter rules and conditions.
a. Click Add a Criterion to add a new filter condition.
b. If you have multiple filter conditions, click And or Or in the And/Or column to
change the logical relationship among the filter conditions.
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c. Hover over a previously added filter condition.
d. Click the delete (

) button to delete the filter condition.

Click Search to start the search or click Cancel to exit the Advanced Search interface
without saving any configurations.
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Building Plans
In Content Manager, you can create plans to copy or move content so that you can repeat the
process without having to reconfigure all settings. Plans also allow you the flexibility of
performing the job at a scheduled time. You can create plans in one of the following two ways:
•

Wizard Mode – For users who are not familiar with creating Content Manager
plans, Wizard Mode provides step-by-step guidance when creating a plan.

•

Form Mode – For more advanced users, Form Mode provides more flexibility in
which settings you configure first.

Building Plans Using Wizard Mode

To create a plan using Wizard Mode, click Online Content Manager on the ribbon in the Home
tab to enter the online mode. Then select the source node in the Source pane and select the
destination node in the Destination pane.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a
site with 2010 experience version, it can only be copied or moved to the site with the same
experience version.
*Note: When selecting My Site in the Source pane, make sure that the application pool account
of the destination Web application meets the following conditions:
•

Is the Administrator of the User Profile Service currently in use.

•

Has Full Control permission to the User Profile Service currently in use.

Click Plan Builder on the ribbon, and then select Wizard Mode from the drop-down menu. You
will be brought to the Wizard Mode tab. To create your plan, complete the following steps:
1. Plan Name – Enter the new Plan Name, and an optional description. Click Next.
2. Method – Configure the method and action for this plan:
a. Method – Select Copy or Move for the type of job you want Content Manager

to run when this plan is executed. If you select Move, you may also configure the
following settings:
o

Source Deletion Method – Select Manual to delete the source content
yourself once the copy/move job is complete (select the copy/move job in
Job Monitor, then click Delete on the ribbon and select Delete Content
from the drop-down list) or select Automatic to have DocAve delete the
source content once the copy/move job is complete.
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o

Delete Source Checked Out Documents – Select Yes if you want to have
DocAve delete the checked-out documents which are not checked out by
the Agent account on the source node when source content is deleted. By
default, No is selected, which means the checked-out documents which
are not checked out by the Agent account will not be deleted on the
source. DocAve will delete the checked-out documents that are checked
out by the Agent account regardless of the selection of Delete Source
Checked Out Documents option when the source content is deleted.

b. Action – Select Attach to transfer the source node as a child node underneath
the destination node, or select Merge to add the content, securities, and

configurations of the source node to the destination node. To see what the data
tree of the destination node will look like after the job is executed, click Show

Preview. The source node is marked by a prompt message: From Source.
c. Promote Method – Choose to promote only the top-level site to the site

collection or promote all of the selected sites to site collections. This section only
appears when satisfying all of the following conditions:
o

Select site collection level or site level nodes in the source tree and select
the Web application node in the destination tree.
*Note: When you select site collection level nodes as the source, only the
Promote all sites to site collections option is available.

o

Select Merge as the Action option.

d. Which managed path would you like to use in the destination? – Changes the
managed path in the destination. Select the Change the managed path in

destination checkbox to configure the managed path you are about to use by
entering the desired value in the Enter an existing Wildcard Inclusion

Managed Path text box. This section only appears when satisfying all of the
following conditions:
o

Select site collection level or site level nodes in the source tree and select
the Web application node in the destination tree.

o

Select Merge as the Action option.

3. When you have finished configuring the method for this plan, click Next.
4. Data Selection – Configure the following settings:
a. Filter Policy – Select a filter policy from the drop-down list or click New Filter
Policy. Filter policies allow you to select specific objects or data within each
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SharePoint level from site collection down to the item level. For information on
creating a filter policy, see the DocAve 6 Control Panel Reference Guide.

*Note: When using the filter policy in SharePoint Online, the Created By rule is
not supported. Exceptions will be recorded in the job report.

b. Configuration – Choose if you want to migrate the configurations to the
destination:
o

Select the Copy/Move configuration checkbox to copy or move the
properties, descriptions, titles, settings, and features from the source node
to the destination node. If you want to keep the look and feel of the
source site including the quick launch, top link bar, tree view, site theme,
and master page, and then select the Keep look and feel checkbox.
*Note: The Keep look and feel function will only take effect when the
following are in place:


The source node is a site, the destination node is a site collection;
or the source node is a top-level site or a site, the destination
node is a Web application.



Merge is selected as the action to take in the Action field.

Click Advanced to select the configurations that you want to copy or

move:


Site Collection Level – Site collection features and properties.



Site Level – Site features and properties, Site column and content
type, Navigation and quick launch, Site template and list template,
Web parts, page layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you
cannot deselect the checkboxes of the Site features and

properties, Navigation and quick launch, and Web parts, page
layout, master pages and other hidden lists.



List Level – List settings, Public views, and List alerts.
*Note: The item alert (including folder alerts, document alerts, and
item alerts) is controlled by the <RestoreItemAlerts

value="True" /> node in the SP2010CMConfiguration.xml file
under the following directory of the destination DocAve Agent

server: \AvePoint\DocAve6\Agent\data\SP2010\ContentManager.
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The SharePoint version in this path will differ according to your
destination SharePoint version.

*Note: In the Create a New Plan interface, the visibility of Site Collection
Level, Site Level, and List Level will change according to the selected

Source node and Destination node.
o

Leave the Copy/Move configuration checkbox deselected if you don’t
want to migrate the configuration to the destination. For more
information on how to configure the Configuration section, refer to
Configuring the Configuration Section.

c. Security – Select the Copy/Move security checkbox to copy or move the user
and/or group permissions from the source node to the destination node,

including SharePoint permission level and permission inheritance of SharePoint
objects. Select the Exclude user/group without permission checkbox to not

copy or move users and/or groups that have no permissions.

*Note: The definition of users or groups without permission varies with the
selected source node:
o

If the source node is a site collection, the users or groups that meet the
following two conditions are the users or groups without permissions:


Users or groups that exist in the source node but are not Site
Collection Administrators.



Users or groups that exist in the source node but have no
permissions to the top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each

site collection are handled individually, and you can refer to the definition
above.
o

o

If the source node is a site, users or groups without permissions refer to
the users or groups that exist in the source node but have no permissions
to this site.
If the source node is an object whose level is lower than the site level,
users or groups without permissions refer to the users or groups that exist
in the source node but have no permissions to the site where the source
object resides.

You cannot view these types of users or groups in the People and Groups –

[SiteName] Members page of a site, but you can view them in the People and

Groups – All People page. To go to the People and Groups – All People page,
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modify the value of MembershipGroupId in the URL of the People and Groups

– [SiteName] Members page to MembershipGroupId=0. You will be redirected
to the People and Groups – All People page.

d. Content – Select the Copy/Move content checkbox to copy/move content in

libraries, folders and items from the source node to the destination node. Select
the Include list attachment to also copy/move attached content in lists.

e. User Profile – Select the Copy/Move user profile checkbox if you want to move
user profiles from the source node to the destination node.

*Note: This section will only appear if the source node level is equal to or higher
than the site collection level because users are saved in the top-level site.
f.

Workflow – Select the Include workflow definition checkbox to copy/move the

definition of existing workflows for the selected content from the source node to
the destination node. Select the Include workflow instance to copy/move the
state, history and tasks of existing workflows for the selected content from the
source node to the destination node. By default, the Include completed

instance checkbox is selected. You can select Include running instance

checkbox if you want to copy/move the currently running instance in the source
node to the destination node, and then select one of the following options:
o

Cancel workflows – Cancel the copied or moved running workflows in
the destination node after the Content Manager jobs.

o

Restart workflows – Restart the copied or moved running workflows in
the destination node after the Content Manger jobs.

*Note: Content Manager does not support the workflow instances associated
with checked-out files.

g. Managed Metadata Service Setting – Select the Managed Metadata Term

Sets or Terms associated with this content checkbox if you want to copy the

associated term sets or the terms and their parent term sets associated with the

content from the source node to the destination node, and then select one of the
following options:
o

Term – Copy terms that are used in the source, their parent terms, the
term sets where the used terms reside, and the names of the groups
where the used terms reside to the destination.
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o

Term set – Copy the whole term sets where the used terms reside in the
source (regardless if the terms in the term sets are used by the source
node or not) to the destination.

*Note: By default, Content Manager does not support copying a Managed

Metadata Service. However, Content Manager supports it after modifying the
<IsBackupManagedMetadataServiceLevel value="False" /> node in the

SP2010CMConfiguration.xml file under the following directory of the

destination DocAve Agent server:

\AvePoint\DocAve6\Agent\data\SP2010\ContentManager.
*Note: You can also copy a Managed Metadata Service by configuring a shared

service mapping using DocAve Deployment Manager. For more information, refer
to the Mapping Settings for Shared Service section in the DocAve 6
Deployment Manager User Guide.

5. When you have finished configuring the data selection settings, click Next.
6. Schedule – Configure a schedule for this plan:
•

If you selected Copy in the Method section, choose one of the following options:
o
o

•

Select No Schedule to manually execute this plan.
Select Start Time if you want to have the plan executed at a selected
time. If applicable, you can change the time zone by clicking on the
hyperlink to select a different time zone.

If you selected Move in the Method section, choose one of the following
options:
o

Select No Schedule to manually execute this plan.

o

Select Configure the schedule myself to determine the frequency to run
this recurring schedule. Configure the following sections:
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Start time – Select the time when this plan is executed.



Interval – Specify the interval for this plan.



No end date – The Move jobs will run on a configured schedule
until you manually end it.



End after __occurrences – The Move jobs will stop running after
the number of times you select here.



End by __– The Move jobs will end on the date and time you enter
here.
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7. When you have finished configuring the schedule, click Next.
8. Advanced – Configure the following advanced settings:
a. Preserve the Null Column Values – Select Yes to preserve the null values of
item columns or select No to replace null values with default values in the

destination node.

b. Folder Structure Management – Choose if you want to collapse the folder

structure of the copied or moved content. Select the Collapse Folder Structure
checkbox to enable this feature. DocAve also allows you to add a column to the

destination for displaying the source folder path or parent folder name. Select

the Add a column to display the source folder path or parent folder name

checkbox to enable this feature.
o

o

Column to display the source folder path – Enter a column name in the
text box to add a Single Line of Text column to display the source folder
path.
Column to display the parent folder name – Enter a column name in
the text box to add a Single Line of Text column to display the source
parent folder name.

*Note: This section only appears when you selected list or folder level nodes in
the source tree.

c. Data Compression – Select the Compression checkbox if you want to compress
the data when it is copied/moved. If you choose to compress the data, use the

slider to select the compression rate. Faster compression rate results in larger

data sets. The best compression rate is a smaller, better quality data set. However,

the compression takes more time to perform.

*Note: Smaller data sets take longer to backup and recover.
d. Backup Environment Before Running Plan – Choose from the following
configurations:
o

o

Select the Backup the source environment checkbox to create a copy of
the source node prior to performing the move. This option only appears
when moving jobs.
Select the Backup the destination environment checkbox to create a
copy of the destination node prior to performing the copy/move job. If
you choose this option, you must first designate a storage policy. Select a
storage policy or click New Storage Policy to create a new one from the
Storage policy drop-down list.
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*Note: Content Manager only supports the Backup type storage policy for
the retention rule. For more information on storage policies, see the
DocAve 6 Control Panel Reference Guide.

e. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level
conflict resolution drop-down list. Select the Check lower objects checkbox if
you want to configure the content level conflict resolution, then choose Skip,

Overwrite, Overwrite by Last Modified Time, or Append from the Content

level conflict resolution drop-down list. For detailed information on how

Content Manager resolves conflicts based on these configurations, see Appendix
A: Conflict Resolution.

f.

Apps Conflict Resolution – Choose Skip, Update App Only, or Replace App
and AppData from the Apps conflict resolution drop-down list. This only

appears when the selected source and destination nodes are in the SharePoint

2013 environments. For detailed information on how Content Manager resolves
apps conflicts based on these configurations, see Apps Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.

g. Agent Group – Select a source or a destination Agent group to execute the
Content Manager job.
o

o

Source Agent Group – Select a source Agent group to back up the data
in the selected source nodes. This option only appears when the selected
source node is in the SharePoint on-premises environment.
Destination Agent Group – Select a destination Agent group to restore
the backed up source data to the destination node. This option only
appears when the selected destination node is in the SharePoint onpremises environment.

h. Notification – Choose the type of notification report and designate which

DocAve user will receive the email notification. Select a notification profile from
the drop-down list. Click View beside the drop-down list to view details of the

notification profile or click New Notification Profile. For information on creating

a notification profile, see the DocAve 6 Control Panel Reference Guide.
i.

Associated Plan Group – Adds the plan to one or more plan groups to manage

the plans with common settings. Select a plan group from the drop-down list or

click New Plan Group. For information on creating a plan group, see the DocAve
6 Control Panel Reference Guide.
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j.

Column Mapping – Maps source columns to the configured columns in the

destination or change the column name to another one. The source columns will

be mapped according to the selected column type, and the column values will be
mapped according to the added value mappings. According to the column type,

the source column and the destination column can be the same or different. The
column can also be changed to Managed Metadata or Lookup. Select a column
mapping from the drop-down list or click New Column Mapping. For

information on creating a column mapping, see the DocAve 6 Control Panel
Reference Guide.

*Note: If you select the column type Change to Lookup while setting up your

column mapping, make sure that the Lookup column can only be associated with

the list or list column that exists in the destination.

k. Content Type Mapping – Maps source content types to the configured content

types in destination, or change the content type name to another one, according

to the condition that you set up. Select a content type mapping from the drop-

down list or click New Content Type Mapping. For information on creating a

content type mapping, see the DocAve 6 Control Panel Reference Guide.

*Note: Make sure that the source content type and the destination content type
are compatible.
l.

Template Mapping – Replaces site and list templates. By inputting or selecting a
template ID, the source template is changed to the destination template. Select a

template mapping from the drop-down list or click New Template Mapping. For
information on creating a template mapping, see the DocAve 6 Control Panel

Reference Guide.

m. User Mapping – Replaces an existing source node username with an existing

destination node username or a default username in the destination. You can

also add a place holder account to keep user metadata even if the user no longer
exists. Select a user mapping from the drop-down list or click New User

Mapping. For information on creating a user mapping, see the DocAve 6 Control
Panel Reference Guide.

n. Domain Mapping – Maps a source domain to a destination domain. The source
domain name will be replaced by the configured destination domain name, and
the user in the source domain will be mapped to the destination user which has

the same login name. Select a domain mapping from the drop-down list or click
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New Domain Mapping. For information on creating a domain mapping, see the

DocAve 6 Control Panel Reference Guide.

o. Language Mapping – Choose if you want to display destination node in a

different language other than source node after the plan has been executed.
Select a language mapping from the drop-down list or click New Language

Mapping. For information on creating a language mapping, see the DocAve 6
Control Panel Reference Guide.

p. List Name Mapping – Choose if you want to change the existing source lists of

the copied or moved objects to your designated lists in the destination. Select a
list name mapping from the drop-down list or click New List Name Mapping.

For information on creating a list name mapping, see the DocAve 6 Control Panel

Reference Guide.

9. When you have finished configuring the advanced settings, click Next.
10. Overview – Once you have finished configuring this plan, you can review and edit the
various settings for this plan. In the Settings tab of the Overview pane, click Edit in any
section to make changes to the settings in that section. In the Preview tab, click Show
Preview to see what the data tree of the destination will look like after the job is run. The
source node is marked by a prompt message: From Source.
11. After you have reviewed all the settings and scopes in the Overview pane, click Finish
on the ribbon, and then select Finish from the drop-down list to save the plan. To save
the plan and execute it right away, click Finish on the ribbon, and then select Finish and
Run Now from the drop-down list.
12. At any time, click Cancel on the ribbon to return to the Home tab of Content Manager.

Configuring the Configuration Section
Refer to this section on how to configure the Configuration section. After deselecting the
Copy/Move configuration checkbox, choose from the following options:
•

Select Copy/Move the item-dependent columns and content types to
maintain item integrity. Then, select a conflict resolution method for these
items’ columns and content types from the drop-down list:
o

o

Do not copy/move the columns and content types, or the
corresponding items – Ignores the conflicting columns, content types,
and the corresponding items, and do nothing on the source and
destination node.
Overwrite the columns and content types – Overwrites the destination
columns and content types with the source node.
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o

•

Append the columns and content types to destination – Keeps the
destination columns and content types when there is a conflict. Copies
the source columns and content types to the destination node with a
numerical suffix added (for example, ColumnName_1, ColumnName_2,
etc.).

Select Do not copy/move the item-dependent columns or content types. The
corresponding item-dependent columns or content types are not copied/moved
to the destination. If the item-dependent columns or content types do not exist
in the destination, the items will not be copied/moved to the destination. If the
item-dependent columns or content types already exist in the destination, the
items will be copied/moved to the destination. The job report will show items if
the corresponding column or content type is not found in the destination node.

Building Plans Using Form Mode

To create a plan using Form Mode, click Online Content Manager on the ribbon in the Home
tab. Select the source node in the Source pane, and select a destination node in the
Destination pane.
*Note: For the SharePoint on-premises environment, make sure that the source node and the
destination node are in the same version of SharePoint. If the site within SharePoint 2013 is a
SharePoint 2010 mode site, it can be copied or moved to the same on-premises mode site, or a
SharePoint Online site.
*Note: When selecting My Site in the Source pane, make sure that the application pool account
of the destination Web application meets the following conditions:
•

Is the Administrator of the User Profile Service currently in use.

•

Has Full Control permission to the User Profile Service currently in use.

Click Plan Builder on the ribbon, and then select Form Mode from the drop-down list. You will
be redirected to the Form Mode tab. To create your plan, complete the following steps:
1. Plan Name – Enter the new Plan Name, then enter an optional description. Click Next.
2. Method – Select Copy or Move for the type of job you want to run. If you select Move,
you may also configure the following settings:
•

Source Deletion Method – Select Manual to delete the source content yourself
once the copy/move job is complete (select the copy/move job in Job Monitor,
then click Delete on the ribbon and select Delete Content from the drop-down
list) or select Automatic to have DocAve delete the source content once the job
is complete.

•

Delete Source Checked Out Documents – Select Yes if you want to have
DocAve delete the checked-out documents which are not checked out by the
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Agent account on the source node when source content is deleted. By default,
No is selected, which means the checked-out documents which are not checked
out by the Agent account will not be deleted on the source. DocAve will delete
the checked-out documents which are checked out by the Agent account
regardless of the selection of Delete Source Checked Out Documents option
when the source content is deleted.
3. Action – Select Attach to transfer the source node as a child node underneath the
destination node, or select Merge to add the content, securities, and configurations of
the source node to the destination node. To see what the data tree of the destination
node will look like after the job is executed, click Show Preview.
4. Promote Method – Choose to promote only the top-level site to the site collection or
promote all selected sites to site collections. This section only appears when satisfying all
of the following conditions:
•

Select site collection level or site level nodes in the source tree and select the
Web application node in the destination tree.
*Note: When you select site collection level nodes as the source, only the
Promote all sites to site collections option is available.

•

Select Merge as the Action option.

5. Which managed path would you like to use in the destination? – Select the Change
the managed path in destination checkbox to configure the managed path you are
about to use by entering the desired value in the Enter an existing Wildcard Inclusion
Managed Path text box. This section only appears when satisfying all of the following
conditions:
•

Select site collection level or site level nodes in the source tree and select the
Web application node in the destination tree.

•

Select Merge as the Action option.

6. Backup Environment Before Running Plan – Configure the following configurations:
•

Select the Backup the source environment checkbox to create a copy of the
source node prior to performing the move. This option only appears for move
jobs.

•

Select the Backup the destination environment checkbox to create a copy of
the destination node prior to performing the copy/move job. If you choose to
back up the destination environment before performing a copy/move, you must
designate a storage policy. Select a storage policy or click New Storage Policy to
create a new one.
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*Note: Content Manager only supports the Backup type storage policy for
retention rule. For more information on storage policies, see the DocAve 6

Control Panel Reference Guide.

7. Schedule – Configure a schedule for this plan:
•

•

If you selected Copy in the Method section, choose one of the following options:
o

Select No Schedule to manually execute this plan.

o

Select Start Time to have this plan execute at a specified time. You may
change the time zone by clicking on the hyperlink next to Start Time.

If you selected Move in the Method section, choose one of the following
options:
o

Select No Schedule to manually execute this plan.

o

Select Configure the schedule myself to specify the frequency to run
this recurring schedule. Configure the following settings:


Start time – Specify the time when this plan is executed.



Interval – Select the interval for this plan.



No end date – The Move jobs will run on a configured schedule
until you manually end it.



End after __occurrences – The Move jobs will stop running after
the number of times you enter here.



End by __– The Move jobs will end on the date and time you
specify here.

8. Click Advanced to configure more options.
9. Filter Policy – Select a filter policy from the drop-down list or click New Filter Policy.
Filter policies allow you to select specific objects or data within each SharePoint level
from site collection down to the item level. For information on creating a Filter Policy, see
the DocAve 6 Control Panel Reference Guide.
*Note: When using the filter policy in SharePoint Online, the Created By rule is not
supported. Exceptions will be recorded in the job report.

10. Configuration – Choose if you want to migrate the configurations to the destination:
•

Select the Copy/Move configuration checkbox to copy/move the properties,
descriptions, titles, settings, and features from the source node to the destination
node. If you want to keep the look and feel of the source site including the quick
launch, top link bar, tree view, site theme, and master page. Then select the Keep
look and feel checkbox.
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*Note: The Keep look and feel function will only take effect when the followings

are in place:
o

o

The source node is a site, the destination node is a site collection; or the
source node is a top-level site or a site, the destination node is a Web
application.
Merge is selected as the action to take in the Action field.

Click Advanced to select the configurations that you want to copy or move:
o
o

Site Collection Level – Site collection features and properties.
Site Level – Site features and properties, Site column and content type,
Navigation and quick launch, Site template and list template, Web parts,
page layout, master pages and other hidden lists.
*Note: If you have selected the Keep look and feel checkbox, you cannot
deselect the checkbox of the Site features and properties, Navigation

and quick launch, and Web parts, page layout, master pages and
other hidden lists.
o

List Level – List settings, Public views, and List alerts.
*Note: The item alert (including folder alerts, document alerts, and item

alerts) is controlled by the <RestoreItemAlerts value="True" /> node in
the SP2010CMConfiguration.xml file under the following directory of
the destination DocAve Agent server:

\AvePoint\DocAve6\Agent\data\SP2010\ContentManager. The SharePoint

version in this path will differ according to your destination SharePoint
version.

*Note: In the Create a New Plan interface, the visibility of Site Collection Level,

Site Level, and List Level will change according to the selected Source node and

Destination node.
•

Leave the Copy/Move configuration checkbox deselected if you don’t want to
migrate the configurations to the destination. Then, choose from the following
options:
o

Select Copy/Move the item-dependent columns and content types to
maintain item integrity. Select a conflict resolution method for these
items’ columns and content types from the drop-down list:
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types, and the corresponding items, and do nothing on the source
and destination node.

•



Overwrite the columns and content types – Overwrites the
destination columns and content types with the source node.



Append the columns and content types to destination – Keeps
the destination columns and content types when there is a
conflict. Copies the source columns and content types to the
destination node with a numerical suffix added (for example,
ColumnName_1, ColumnName_2, etc.).

Select Do not copy/move the item-dependent columns or content types. The
corresponding item-dependent columns or content types are not copied/moved
to the destination. The job report will show items if the corresponding column or
content type is not found in the destination node.

11. Security – Select the Copy/Move security checkbox to copy/move the user and/or
group permissions from the source node to the destination node, including SharePoint
permission level and permission inheritance of SharePoint objects. Select the Exclude
user/group without permission checkbox to not copy or move users and/or groups
that have no permissions
*Note: The definition of users or groups without permission varies with the selected
source node:
•

If the source node is a site collection, the users or groups that meet the following
two conditions are the users or groups without permissions:
o

Users or groups that exist in the source node but are not Site Collection
Administrators.

o

Users or groups that exist in the source node but have no permissions to
the top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each site

collection are handled respectively, and you can refer to the definition above.
•

If the source node is a site, users or groups without permissions refer to the users
or groups that exist in the source node but have no permissions to this site.

•

If the source node is an object whose level is lower than the site level, users or
groups without permissions refer to the users or groups that exist in the source
node but have no permissions to the site where the source object resides.

You cannot view these types of users or groups in the People and Groups – [SiteName]

Members page of a site, but you can view them in the People and Groups – All People

page. To go to the People and Groups – All People page, modify the value of
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MembershipGroupId in the URL of the People and Groups – [SiteName] Members

page to MembershipGroupId=0. You will be brought to the People and Groups – All
People page.

12. Content – Select the Copy/Move content checkbox to copy/move content in libraries,
folders and items from the source node to the destination node. Select the Include list
attachment to also copy/move attached content in lists.
13. User Profile – Select the Copy/Move user profile checkbox if you want to move user
profiles from the source node to the destination node.
*Note: This section will only appear if the source node level is equal to or higher than
the site collection level because users are saved in the top-level site.

14. Workflow – Select the Include workflow definition checkbox to copy/move the
definition of existing workflows for the selected content from the source node to the
destination node. Select the Include workflow instance to copy/move the state, history
and tasks of existing workflows for the selected content from the source node to the
destination node. The Include completed instance checkbox is selected to copy/move
the completed instance from the source node to the destination node. You can select
Include running instance checkbox if you want to copy/move the currently running
instance, and then select one of the following options:
•

Cancel workflows – Cancel the copied or moved running workflows in the
destination node after the Content Manager jobs.

•

Restart workflows – Restart the copied or moved running workflows in the
destination node after the Content Manger jobs.
*Note: Content Manager does not support the workflow instances associated
with checked-out files.

15. Managed Metadata Service Setting – Select the Managed Metadata Term Sets or
Terms associated with this content checkbox if you want to copy the associated term
sets or the terms and their parent term sets associated with the content from the source
node to the destination node, and then select one of the following options:
•

Term – Copy terms that are used in the source, their parent terms, the term sets
where the used terms reside, and the names of the groups where the used terms
reside to the destination.

•

Term set – Copy the whole term sets where the used terms reside in the source
(regardless if the terms in the term sets are used by the source node or not) to
the destination.

*Note: By default, Content Manager does not support copying a Managed Metadata
Service. However, Content Manager supports it after modifying the
®
DocAve 6 Content Manager

58

<IsBackupManagedMetadataServiceLevel value="False" /> node in the

SP2010CMConfiguration.xml file under the following directory of the destination

DocAve Agent server: \AvePoint\DocAve6\Agent\data\SP2010\ContentManager.

*Note: You can also copy a Managed Metadata Service by configuring a shared service

mapping using DocAve Deployment Manager. For more information, refer to the

Mapping Settings for Shared Service section in the DocAve 6 Deployment Manager
User Guide.

16. Preserve the Null Column Values – Select Yes to preserve the null values of item
columns (such as newly created columns) or select No to replace null values with default
values in the destination node.
17. Folder Structure Management – Choose if you want to collapse the folder structure of
the copied or moved content. Select the Collapse Folder Structure checkbox to enable
this feature. DocAve also allows you to add a column to the destination for displaying
the source folder path or parent folder name. Select the Add a column to display the
source folder path or parent folder name checkbox to enable this feature as well.
•

Column to display the source folder path – Enter a column name in the text
box to add a Single Line of Text column to display the source folder path.

•

Column to display the parent folder name – Enter a column name in the text
box to add a Single Line of Text column to display the source parent folder
name.

*Note: The Folder Structure Management filed only appears when you've selected list
or folder level nodes in the source tree.

18. Data Compression – Select the Compression checkbox if you want to compress the
data when it is copied/moved. If you choose to compress the data, use the slider to
select the compression rate. Faster compression rate result in a larger data sets. The best
option is a smaller, better quality data set, but the compression takes more time to
perform.
*Note: Smaller data sets take longer to backup and recover.
19. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level
conflict resolution drop-down list. Select the Check lower objects checkbox, then
choose Skip, Overwrite, Overwrite by Last Modified Time, or Append from the
Content level conflict resolution drop-down list. For detailed information on how
Content Manager resolves conflicts based on these configurations, see Appendix A:
Conflict Resolution.
20. Apps Conflict Resolution – Choose Skip, Update App Only, or Replace App and
AppData from the Apps conflict resolution drop-down list. This field will only appear
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when the selected source and destination nodes are in the SharePoint 2013
environments. For detailed information on how Content Manager resolves apps conflicts
based on these configurations, see Apps Conflict Resolution.
*Note: Apps Conflict Resolution only takes effect on the app instances.
21. Agent Group – Select a source or a destination group to execute the Content Manager
job.
•

Source Agent Group – Select a source Agent group to back up the data in the
selected source nodes. This option only appears when the selected source nodes
are in the SharePoint on-premises environments.

•

Destination Agent Group – Select a destination Agent group to restore the
backed up source data to the destination node. This option only appears when
the selected destination node is in the SharePoint on-premises environment.

22. Notification – Choose the type of notification report and designate which DocAve user
will receive an email notification. Select a notification profile from the drop-down list.
Click View beside the drop-down list to view details of the notification profile or click
New Notification Profile from the drop-down list. For information on creating a
notification profile, see the DocAve 6 Control Panel Reference Guide.
23. Associated Plan Group – Add the plan to one or more plan groups to manage plans
with common settings. Select a plan group from the drop-down list, or click New Plan
Group. For information on creating a plan group, see the DocAve 6 Control Panel
Reference Guide.
24. Column Mapping – Maps source columns to the configured columns in the destination,
or change the column name to another one, according to the condition that you set up.
The specified source columns will be mapped according to the selected column type,
and the column values will be mapped according to the added value mappings.
According to the column type, the source column and the destination column can be the
same or different. The column can also be changed to Managed Metadata or Lookup.
Select a column mapping from the drop-down list or click New Column Mapping. For
information on creating a column mapping, see the DocAve 6 Control Panel Reference
Guide.
*Note: If you select the column type Change to Lookup while setting up your column

mapping, make sure that the Lookup column can only be associated with the list or list
column that exists in the destination.

25. Content Type Mapping – Replaces source content types with destination content types
according to the condition that you set up. Select a content type mapping from the

®
DocAve 6 Content Manager

60

drop-down list or click New Content Type Mapping. For information on creating a
content type mapping, see the DocAve 6 Control Panel Reference Guide.
26. Template Mapping – Replaces site and list templates. By inputting or selecting a
template ID, the source template is changed to the destination template. Select a
template mapping from the drop-down list or click New Template Mapping. For
information on creating a template mapping, see the DocAve 6 Control Panel Reference
Guide.
27. User Mapping – Maps a source user to a target user. If the same user has a different
username in Domain A than in Domain B, or if you want to copy or move an individual
user’s content, permissions, and metadata in Domain A to another user in Domain B, the
user’s permissions and metadata will not be lost when content is moved. Select a user
mapping from the drop-down list or click New User Mapping. For information on
creating a user mapping, see the DocAve 6 Control Panel Reference Guide.
28. Domain Mapping – Maps a source domain to a destination domain. The source domain
name will be replaced by the configured destination domain name. The user in the
source domain will be mapped to the destination user which has the same login name.
Select a domain mapping from the drop-down list or click New Domain Mapping. For
information on creating a domain mapping, see the DocAve 6 Control Panel Reference
Guide.
29. Language Mapping – Displays the destination node in a different language than source
node after the plan has been executed. Select a language mapping from the drop-down
list or click New Language Mapping. For information on creating a language mapping,
see the DocAve 6 Control Panel Reference Guide.
30. List Name Mapping – Changes the existing source lists of the copied or moved objects
to your designated lists in the destination. Select a list name mapping from the dropdown list or click New List Name Mapping. For information on creating a list name
mapping, see the DocAve 6 Control Panel Reference Guide.
31. Click Save on the ribbon, and then select Save from the drop-down list to save the plan.
To save the plan and execute it right away, click Save on the ribbon, and then select
Save and Run Now from the drop-down list.
32. At any time, click Cancel on the ribbon to abandon the new plan’s configuration and
return to the Home tab of Content Manager.

Managing Plans

Content Manager allows you to create plans so that you can repeat copy/move jobs without
having to reconfigure settings each time. When a plan is created, it will appear in Plan Manager.
To access Plan Manager, click the Plan Manager tab at the top of the DocAve interface.
You may perform any of the following actions on a selected plan:
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•

View Details – To view detailed information of the selected plan:
o

o

•

Select the plan by selecting the corresponding checkbox, and then click
View Details on the ribbon. The View Details interface appears.
Click the down arrow ( ) button in the Plan Name column, and then
select View Details from the drop-down menu. The View Details
interface appears with the following options:


Click Edit on the ribbon to make changes to the plan’s settings.
The Edit tab appears.



Click Source & Destination on the ribbon to change the source
and destination nodes for this plan, or click Settings on the
ribbon, and then edit the plan’s settings. For more information on
how to edit the plan settings, refer to Building Plans Using Form
Mode.



Click Save on the ribbon, and then select Save from the dropdown list to save the plan. To save the plan and execute it right
away, select Save and Run Now from the drop-down list. To save
a changed plan as a new one, click Save on the ribbon, and then
select Save As from the drop-down list.



Click Cancel on the ribbon at any time to return to the Plan
Manager.

Edit – Edit the plan settings of the selected plan:
o

Select the plan by selecting the corresponding checkbox, and then click
Edit on the ribbon. The Edit tab appears.

o

Click the down arrow ( ) button in the Plan Name column, and then
select Edit from the drop-down menu. The Edit tab appears.
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Click Source & Destination on the ribbon, and then change the
source and destination nodes for this plan, or click Settings on the
ribbon, and then edit the plan’s settings. For more information on
how to edit the plan settings, refer to Building Plans Using Form
Mode.



Click Save on the ribbon, and then select Save from the dropdown list to save the plan. To save the plan and execute it right
away, click Save on the ribbon, then select Save and Run Now
from the drop-down list. To save a changed plan as a new one,
click Save on the ribbon, and then select Save As from the dropdown list.
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•

Click Cancel on the ribbon at any time to return to the Plan
Manager.

Delete – Delete the selected plan:
o

o

Select the plan to delete by selecting the corresponding checkbox, and
then click Delete on the ribbon. A warning message will appear to
confirm the deletion. Click OK to delete the selected plan or click Cancel.
Click the down arrow ( ) button in the Plan Name column, and then
select Delete from the drop-down menu. A warning message will appear
to confirm the deletion. Click OK to delete the selected plan or click
Cancel.

•

Test Run – Click Test Run on the ribbon to simulate the execution of the
selected plan. You can see the results of the test run in Job Monitor. For more
information, see the DocAve 6 Job Monitor Reference Guide.

•

Run Now – Click Run Now on the ribbon to execute the plan immediately. You
can see the review details about the plan’s execution in Job Monitor. For more
information, see the DocAve 6 Job Monitor Reference Guide.
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Using Data Import and Data Export
In cases where the desired source and destination nodes cannot communicate with each other
(for example, if there is a firewall), Content Manager allows you to export the content from the
source node to an Export Location, and then import it into the destination node.

Exporting Content

To export the content to an export location, click Data Export on the ribbon in the Home tab.
Then select the desired source node in the Source pane, and then configure the following
settings to export content on the right pane:
1. Plan Name – Enter the new Plan Name, then enter an optional description.
2. Export Location – Select an export location in Control Panel or click New Export
Location to create a new one. For information on creating export locations, see the
DocAve 6 Control Panel Reference Guide. Only the Net Share storage type is supported
for an export location.
3. Schedule – Configure a schedule for this plan by selecting one of the following options:
•

Select No Schedule to manually execute this plan.

•

Select Start Time to have this plan execute at a specified time. If applicable, you
may change the time zone by clicking on the hyperlink to select a different time
zone.

4. Click Advanced to configure additional options.
a. Filter Policy – Select a filter policy from the drop-down list or click New Filter
Policy. Filter policies allow you to select specific objects or data within each

SharePoint level from site collection down to the item level. For information on
creating a filter policy, see the DocAve 6 Control Panel Reference Guide.

*Note: When using the filter policy in SharePoint Online, the Created By rule is
not supported. Exceptions will be recorded in the job report.

b. Content – Select the Export content checkbox to export content in libraries,
folders, and items from the source node to the destination node. Select the
Include list attachment to also export attached content in lists.

c. User Profile – Select the Export user profile checkbox to move user profiles
from the source node to the destination node.

*Note: This section will only appear if the source node level is equal to or higher
than the site collection level because users are saved in the top-level site.
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d. Data Compression – Select the Compression checkbox to compress the data

when it is exported. If you choose to compress the data, use the slider to select

the compression rate. Faster compression rates result in larger data sets. The best
compression rate is a smaller better quality data set, but the compression takes
more time to perform.

*Note: Smaller data sets take longer to backup and recover.
e. Data Encryption – Select the Encryption checkbox to encrypt the data. Then

select the Default Security Profile or a security profile from the drop-down list

to protect your backup data using the security keys generated by the specified
encryption method. Or click New Security Profile to create a new one. For

details on creating a security profile, refer to the DocAve 6 Control Panel

Reference Guide. Note that encrypted data takes longer to backup and recover.

f.

Workflow – Select the Include workflow definition checkbox to export the

definition of existing workflows for the selected content from the source node to
the destination node. Select the Include workflow instance checkbox to also

export the state, history, and tasks of existing workflows for the selected content

from the source node to the destination node.

*Note: Content Manager does not support the workflow instances associated
with checked-out files.

g. Managed Metadata Service Setting – Select the Managed Metadata Term

Sets or Terms associated with this content checkbox if you want to copy the

associated term sets or the terms and their parent term sets associated with the

content from the source node to the destination node, and then select one of the
following options:
o

o

Term – Copy terms that are used in the source, their parent terms, the
term sets where the used terms reside, and the names of the groups
where the used terms reside to the destination.
Term set – Copy the whole term sets where the used terms reside in the
source (regardless if the terms in the term sets are used by the source
node or not) to the destination.

h. Generate Metadata File ‒ Select the Generate Metadata File checkbox to

generate Microsoft Excel files with metadata for each library or list. The metadata
files are stored in the export location you configured. You can edit the metadata
file to add, edit, or delete the metadata of items in batch.
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i.

Agent Group – Select an Agent group to execute the export job. This option only

appears when the selected source nodes are in the SharePoint on-premises
environments.

j.

Notification – Choose the type of notification report and designate which

DocAve user will receive an email notification. Select a notification profile from
the drop-down list. Click View beside the drop-down list to view details of the

notification profile or click New Notification Profile. For information on creating
a notification profile, refer to the DocAve 6 Control Panel Reference Guide.

k. Associated Plan Group – Add the plan to one or more plan groups to manage

plans with common settings. Select a plan group from the drop-down list or click

New Plan Group from the drop-down list to create a new one. For information

on creating a plan group, refer to the DocAve 6 Control Panel Reference Guide.
5. Click Save to save the export plan. To save the export plan and execute it right away,
click Save, and then select Save and Run Now.
6. Click Cancel at any time to abandon the new export plan’s configuration and return to
the Home tab of Content Manager.

Importing Content

To import content from an export location, click Data Import on the ribbon in the Home tab.
The Source pane will be replaced with the Import configuration interface. Then select the
desired destination node in the Destination pane. To import content, configure the following
settings:
1. Plan Name – Enter the new Plan Name, then enter an optional description.
2. Browse – In the Browse tab, click on the export location to expand its data tree. Select
the exported content. Click the Details tab to see what content is included.
3. Action – Select Attach to transfer the source node as a child node underneath the
destination node, or select Merge to add the content, securities, and configurations of
the source node to the destination node. To see what the data tree of the destination
node will look like after the job is executed, click Show Preview.
4. Schedule – Configure a schedule for this plan by choosing one of the following options:
•

Select No Schedule to manually execute this plan.

•

Select Start Time to have this plan execute at a specified time. If applicable, you
may change the time zone by clicking on the hyperlink to select a different time
zone.

5. Click Advanced to configure further options.
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a. Conflict Resolution – Choose Skip, Merge, or Replace from the Container level
conflict resolution drop-down list. Select the Check lower objects checkbox if

you want to configure content level conflict resolution, then choose Skip,

Overwrite, Overwrite by Last Modified Time, or Append from the Content
level conflict resolution drop-down list. For detailed information on how

Content Manager resolves conflicts based on these configurations, see Appendix

A: Conflict Resolution.

b. Configuration – If you want to import the properties, descriptions, titles,

settings, and features from the source node to the destination node, select the

Import configuration checkbox. If you do not want to import the configurations,

leave the checkbox deselected, and configure the following options:
o

o

Select the Import the item-dependent columns and content types to
maintain item integrity radio button to import the item dependent
columns and content types to destination and choose one of the
following options from the Conflict resolution for dependent items
drop-down list:


Do not copy/move the columns and content types, or the
corresponding items – Ignores the conflicting columns, content
types, and the corresponding items and do nothing on the source
and destination node.



Overwrite the columns and content types – Overwrites the
destination columns and content types with that of the source
node.



Append the columns and content types to destination – Keeps
the destination columns and content types when there is a
conflict. In addition, copy the source columns and content types to
the destination node with a numerical suffix added (for example,
ColumnName1, ColumnName2, etc.).

Select the Do not Import the item-dependent columns or content
types radio button to not import item dependent columns or content
types. The corresponding items will not be imported to the destination.
DocAve will report the items if the corresponding column or content type
is not found in the destination node.

c. Security – Select the Import security checkbox to import the user and/or group
permissions from the source node to the destination node, including SharePoint
permission level and permission inheritance of SharePoint objects. Select the

Exclude user/group without permission checkbox to not import users and/or
groups that have no permissions.
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*Note: The definition of users or groups without permission varies with the
selected source node:
o

If the source node is a site collection, the users or groups that meet the
following two conditions are the users or groups without permissions:


Users or groups that exist in the source node but are not Site
Collection Administrators.



Users or groups that exist in the source node but have no
permissions to the top-level site or any sites of the site collection.

*Note: If the source node is a Web application, the permissions of each

site collection are handled individually, and you can refer to the definition
above.

o

o

If the source node is a site, users or groups without permissions refer to
the users or groups that exist in the source node but have no permissions
to this site.
If the source node is an object whose level is lower than the site level,
users or groups without permissions refer to the users or groups that exist
in the source node but have no permissions to the site where the source
object resides.

You cannot view these types of users or groups in the People and Groups –

[SiteName] Members page of a site, but you can view them in the People and

Groups – All People page. To go to the People and Groups – All People page,

modify the value of MembershipGroupId in the URL of the People and Groups
– [SiteName] Members page to MembershipGroupId=0. You will be brought
to the People and Groups – All People page.

d. Managed Metadata Service Setting – Select the Managed Metadata Term

Sets or Terms associated with this content checkbox if you want to copy the

associated term sets or the terms and their parent term sets associated with the
content from the source node to the destination node.

e. Preserve the Null Column Values – Select Yes to preserve the null values of
item columns or select No to replace null values with default values in the
destination node.
f.

Folder Structure Management – Choose whether to collapse the folder

structure of the copied or moved content. Select the Collapse Folder Structure
checkbox to enable this feature. DocAve also allows you to add a column to the

destination for displaying the source folder path or parent folder name of the
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source folder. Select the Add a column to display the source folder path or
parent folder name checkbox to enable this feature as well.
o

o

Column to display the source folder path – Enter a column name in the
text box to add a Single Line of Text column to display the source folder
path.
Column to display the parent folder name – Enter a column name in
the text box to add a Single Line of Text column to display the source
parent folder name.

*Note: The Folder Structure Management field only appears when the source
nodes of the exported data you selected are the list or folder level ones.

g. Backup Environment Before Running Plan – Select the Backup the destination
environment checkbox to create a copy of the destination node prior to

performing the import job. If you choose this option, you must designate a

storage policy. Select a storage policy or click New Storage Policy to create a

new one.

*Note: Content Manager only supports the Backup type storage policy. For more

information on storage policies, see the DocAve 6 Control Panel Reference Guide.
h. Agent Group – Select an Agent group to execute the import job. This option
only appears when the selected destination node is in the SharePoint onpremises environments.
i.

Notification – Choose the type of notification report and designate which

DocAve user will receive an email notification. Select a notification profile from
the drop-down list. Click View beside the drop-down list to view details of the

notification profile or click New Notification Profile. For more information on

creating a notification profile, see the DocAve 6 Control Panel Reference Guide.
j.

Associated Plan Group – Add the plan to one or more plan groups to manage

plans with common settings. Select a plan group from the drop-down list or click
New Plan Group. For information on creating a plan group, see the DocAve 6
Control Panel Reference Guide.

k. Column Mapping – Maps source columns to the destination columns by using a
customized column mapping or an existing metadata file which is generated in
the Export Location. Choose Use Column Mapping and select a column

mapping from the drop-down list or click New Column Mapping from the dropdown list. For information on creating a column mapping, refer to the DocAve 6
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Control Panel Reference Guide. To apply an existing metadata file in the Export
Location to this import job, choose Use existing metadata file.

*Note: If you choose to change a column to a Lookup column, make sure that

the Lookup column can only be associated with the list or list column that exists
in the destination.

l.

Content Type Mapping – Maps source content types to the entered content

types in the destination or changes the content type name to another one. Select
a content type mapping from the drop-down list or click New Content Type

Mapping. For information on creating a content type mapping, refer to the
DocAve 6 Control Panel Reference Guide.

m. Template Mapping – Replaces site templates and list templates. By inputting or
selecting a template ID, the source template is changed to the destination

template. Select a template mapping from the drop-down list or click New

Template Mapping. For information on creating a template mapping, see the
DocAve 6 Control Panel Reference Guide.

n. User Mapping – Maps a source user to a target user. If the same user has a

different username in Domain A than in Domain B, or if you want to move an

individual user’s content, permissions, and metadata in Domain A to another user
in Domain B, the user’s permissions and metadata will not be lost when the

content is moved. Select a user mapping from the drop-down list or click New

User Mapping. For information on creating a user mapping, see the DocAve 6
Control Panel Reference Guide.

o. Domain Mapping – Maps a source domain to a destination domain. The source
domain name will be replaced by the configured destination domain name, and
the user in the source domain will be mapped to the destination user which has

the same login name. Select a domain mapping from the drop-down list or click

New Domain Mapping. For information on creating a domain mapping, see the
DocAve 6 Control Panel Reference Guide.

p. Language Mapping – Displays the destination node in a different language than
the source node after the plan has been executed. Select a language mapping

from the drop-down list, or click New Language Mapping f. For information on

creating a language mapping, see the DocAve 6 Control Panel Reference Guide.

q. List Name Mapping – Changes the existing source lists of the copied or moved
objects to your designated lists in the destination. Select a list name mapping
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from the drop-down list or click New List Name Mapping. For information on

creating a list name mapping, see the DocAve 6 Control Panel Reference Guide.
6. Click Save to save the import plan. To save the import plan and execute it right away,
click Save, and then select Save and Run Now.
7. Click Cancel at any time to return to the Home tab of Content Manager.
*Note: Exported Content Manager data can only be imported into SharePoint through the same
version of DocAve that was used to export the data.

Editing Metadata File

You can edit the metadata file to add, edit, or delete metadata in batch. To edit the metadata
file, complete the following steps:
1. Open the folder Content Manager in the Export Location, and then open the folder
named by Job ID with a _001 suffix.
2. Inside that folder, open the subfolder that is named by GUID to see a list of Microsoft
Excel files. Each library or list generates an Excel file. Columns, items, and their
corresponding column values of a library or list are displayed in the Excel file.
3. You can add, edit, and delete the metadata file in the Excel file.
*Note: The column Content Type: = Computed and the corresponding value cannot be
edited.
•

Add the metadata. Add a column, specify its column type, and set a value for the
item in the Excel file. The newly added column will be imported to the destination
view.
For example, add a new column next to the existing column on the first row,

enter Comments: = Multiple lines of text and set the value of an item as It

needs to be updated. Here Comments is the column name, Multiple lines of

text is the column type, and It needs to be updated is the corresponding value
for the item. After the import job, the column will be added to the destination

default view and the column Comments and the value will also be added as new

metadata for the item.
•

Edit the metadata. Edit the column name and column type of an item and modify
the corresponding value in the Excel file.
For example, in the Excel file, the column name, column type of an item is Name:
= Single line of text and the corresponding value is Document A. You can

modify the column name and the column type to Multi-Name: = Multiple line
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of text, and modify the item column value from Document A to Document B.
After the import job, the column’s name will be Multi-Name and its type is

Multiple line of text, and the item’s Multi-Name column value will be displayed

as Document B in the destination.
•

Delete the metadata. Delete the column name, column type of an item, and the
corresponding value in the Excel file.
For example, in the Excel file, the column name and column type of an item is

Title: = Single line of text and the corresponding value is Custom List. If you do

not want this column title or type and the value for this item to be associated

with the item in the destination after being imported, delete the column name,
column type, and the corresponding value from the cells.
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Advanced Settings
Content Manager offers these additional settings that can be applied to Content Manager plans:
•

Mappings – The available mappings for Content Manager plan are:
o

o

o

o

o

o

o

List Name Mapping allows you to change the existing source lists of the
copied or moved objects to your designated lists in the destination. Select
a list name mapping from the drop-down list or click New List Name
Mapping.
Column Mapping is used to replace source columns with destination
columns. According to column type, the source and destination column
type can be the same or different. The column can be changed to
Managed Metadata or Lookup.
Content Type Mapping allows you to replace the source content types
with the destination content type according to the condition that you set
up.
Template Mapping helps you achieve replacing site template and list
template. By inputting or selecting a template ID, the source template is
changed to the destination template.
User Mapping is beneficial for migrating groups of users from one
domain to another and for migrating an individual user’s content and
permissions to another user.
Domain mapping is used to replace a source domain name with a
domain name in the destination. The user in the source group will be
mapped to the destination user with the same name.
Language Mapping allows you to set a different language for the
destination than the language used in the source. By creating a language
mapping rule, any plans using the rule can repeat the process without
having to manually reenter the settings.

•

Export Location allows you to configure locations on external system storage
where you want Content Manager to export the data. By configuring an external
system storage, you can also export design elements to the file system. This
feature is useful in cases where two farms are unable to communicate with each
other. You can use export locations to perform offline deployments to deploy
from an external device.

•

Storage Policy allows you to specify which logical device to use when storing
content or when performing imports and exports for offline deployment.
*Note: Content Manager only supports the Backup type storage policy.
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•

Filter Policy allows you to set up filter rules so you can control what objects and
data within any SharePoint level appear so that you can target content to migrate
more precisely. By setting up and saving filter policies, you can apply the same
filter policies to different plans without having to recreate them each time.
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Content Manager for SharePoint Online
Content Manager allows you to copy/move content from Microsoft SharePoint 2013/SharePoint
2016 to SharePoint Online. To perform this function properly, you must configure your
SharePoint sites, OneDrive for Business, and Office 365 group team sites in Control Panel. For
more detailed information about this configuration, see the Object Registration section in the
DocAve 6 Control Panel Reference Guide.
Before using Content Manager for SharePoint Online, make sure you have purchased the
corresponding Content Manager for SharePoint Online licenses.
For details about how to perform a simple copy, run a simple move, perform a data export,
perform a data import, or build a plan, refer to Copying Content, Moving Content, Exporting
Content, Importing Content, and Building Plans.
Certain settings are different when the destination node is in a SharePoint Online environment.
To review supported settings for SharePoint Online, refer to Appendix C: Supported and
Unsupported Content Manager Settings for SharePoint Online.
Content Manager for SharePoint Online supports the Create Container function for site
collection, site, list, and folder levels in a SharePoint Online destination node.
If given the corresponding permissions, users in the Tenant groups can view and modify a
DocAve plan, profile, or job created by the other users that are also in this group. For detailed
information on the permission control of the users in the Tenant groups, refer to the DocAve 6
Control Panel Reference Guide.
When selecting the source node and the destination node to perform a Content Manager job,
make sure that the source node and the destination node are in the same version of SharePoint.
However, the Content Manager for SharePoint Online supports to copy or move the contents
from a SharePoint 2013 site with SharePoint 2010 experience version to a SharePoint 2013 site.
For more information, refer to Appendix G: The Supported and Unsupported Methods to Copy
or Move Sites of Different SharePoint Experience Versions.
Content Manager for SharePoint Online supports copying or moving the Apps for SharePoint.
However, there are some limitations for the apps that are not added from the SharePoint App
Store:
•

Because of the Client API limitation, DocAve cannot obtain the app stream stored
in the Microsoft server database. Therefore, DocAve cannot automatically create
an app definition in the destination App Catalog Site Collection.
o

When backing up the app definition, DocAve cannot back up all of the
app definition's installation components. Instead, DocAve obtains and
backs up some properties, such as the Product ID, and Product Version.
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o

•

An app definition that is the same as the source must exist in the
destination App Catalog Site Collection so DocAve can restore the
source app and AppData normally.

Make sure that the user used to register all of the site collections under the My
Registered Sites node in the tree has Read, or above permission to the Apps for
SharePoint library in the App Catalog Site Collection. Otherwise, DocAve
cannot load the Apps node in the tree.

You can use the DocAve Agent that cannot connect to the internet to run a Content Manager
job using SharePoint Online nodes. To do so, you must configure the Agent Proxy Settings in
Control Panel. For more information, refer to the DocAve 6 Control Panel Reference Guide.
Content Manager for SharePoint Online supports copying or moving the SharePoint 2013
Workflow platform. However, only the list level and site level workflows are currently supported.
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Copying/Moving Multiple SharePoint 2016 Site Collections to
SharePoint Online Admin Center

Content Manager allows you to copy/move multiple SharePoint 2016 site collections to a
SharePoint Online admin center at one time.
*Note: This feature is only supported for the simple copy/move job for Online Content
Manager.
After you select one or more SharePoint 2016 site collections from the Source scope and one
SharePoint Online admin center from the Destination scope in Online Content Manager mode,
selecting Copy > Copy or Move > Move in the Online Management Group on the ribbon will
bring to an overview page of settings. Click Next to configure the settings for the job, and only
the Action and Office 365 Container Creation sections are different from the default copy/move
settings. List these two sections below and refer to Copying Content or Moving Content for the
adoption and configurations of other settings
•

Action – Only the Attach action is supported here.

•

Office 365 Container Creation – Configure the destination URL for the source
site collections.
o

o

o

Source URL Path – All of the source site collection you select will be
displayed in this column.
Managed Path – Select either Sites or Teams as the destination
managed path from the drop-down list. You can choose the managed
path for all site collections in batch by clicking the Set Managed Path in
Batch: Sites link or the Set Managed Path in Batch: Teams link.
Office 365 URL Name – Enter the destination URL name for the source
site collection. Make sure the full destination URL must be unique so that
the site can be created in the destination.
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Appendix A: Conflict Resolution
Container Level Conflict Resolution
Resolution

Skip

Object

Conflict

No Conflict

Configuration

Ignore the conflicting configuration
and do nothing on the source and
destination.
Ignore the conflicting security and
do nothing on the source and
destination.
Overwrite the settings in the
destination node with settings from
the source node.
• Source permissions that do not
already exist in the destination
node will be added to the
destination node.
• Permission levels from the
source node will replace those in
the destination node.
• Site collection level, site level, or
folder level – Content,
configurations, and securities of
the destination node will be
replaced with those in the source
node.
• Top-level site level, list/library
level, or root folder level – All
objects under the conflicting
container will be deleted and
replaced with source content,
and configurations. The
securities under the conflicting
container will be merged to the
destination.
*Note: Top-level site level and
sub-site level are regarded as
the same level. That is, if the
conflict exists at the top-level
site level, the sub-site will not be
deleted.

A new SharePoint
object will be
created.
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.

Security
Merge

Configuration
Security

Replace

Configuration
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object will be
created.
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Resolution

Object
Security
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Conflict

No Conflict

Conflicting securities on the
destination node will be overwritten
with that of the source node.

A new SharePoint
object will be
created.
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Content Level Conflict Resolution
Resolution

Object

Skip

Content

Overwrite

Content

Overwrite by
Last Modified
Time

Content

Append

Content

Apps Conflict Resolution
Resolution

Skip
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Conflict

No Conflict

Ignore the conflicting content and
do nothing on source and
destination.
Delete the conflicting content on
destination first and overwrite it with
the source content.
If the last modified time of source
conflicting content is later than that
of destination one, it will overwrite
the destination content by source
one; otherwise, do nothing on the
source and destination node.

A new SharePoint
object will be
created.
A new SharePoint
object will be
created.
A new SharePoint
object will be
created.

The conflicting content will not be
deleted; the conflicting document
will be transferred to the destination
by adding a suffix to the document
name (_1, _2, …, increasing in
numerical value), and the conflicting
item will be transferred to the
destination by adding 1 to the item
ID.

A new SharePoint
object will be
created.

Object

Conflict

No Conflict

App

Ignore the conflicting
app instance and do
nothing on source
and destination.

The source app
instance is created in
the destination.

AppData

Ignore the conflicting
AppData and do
nothing on source
and destination.

The source AppData
is created in the
destination.
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Resolution
Update App Only

Object

Conflict

No Conflict

App

The latest version
app instance will be
kept in the
destination.

The source app
instance is created in
the destination.

AppData

Ignore the conflicting
AppData and do
nothing on source
and destination.

The source AppData
is created in the
destination.

*Note: This will cause
the version of the
app and that of the
AppData to not be
the same version in
the destination after
the Content Manager
job. The app may not
work well.
Replace App and
AppData
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App

The destination app
instance is deleted
while the source app
is created in the
destination.

The source app
instance is created in
the destination.

AppData

The destination
AppData is deleted
while the source
AppData is created in
the destination.

The source AppData
is created in the
destination.
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Appendix B: Supported Online and Offline Content Manager Settings for
SharePoint On-Premises
Refer to the following sections for more information.

Supported Online Content Manager Settings

The following table identifies the supported settings for copy and move jobs using SharePoint on-premises nodes.
*Note: The options that only exist for moves have been marked as (Move Only). The options that only exist for Merge have been
marked as (Merge Only).
Supported Online Settings
Action

Attach
Merge
Preview

Promote Method (Merge
Only)

Promote top-level site to site collection
Promote all sites to site collections

Which managed path would you like to use in the destination? (Merge Only)
Filter Policy
Select Source
Components

Configuration

Copy/Move configuration

Keep look and feel (Merge Only)
Advanced:
Site Collection Level
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Supported Online Settings
Site Level
List Level
Deselect Copy/Move
configuration

Do not copy/move the columns and content types, or
the corresponding items
Overwrite the columns and content types

Copy/Move the item dependent
columns and content types to
maintain item integrity

Append the columns and content types to
destination

Do not copy/move the item dependent columns or content types. Report the items if the
corresponding column or content type is not found in destination.
Security

Exclude user/group without permission

Content

Include list attachment

User Profile
Workflow

Include workflow definition
Include workflow instance

Include completed instance
Include running instance

Cancel workflows
Restart workflows

Managed
Metadata Service
Setting

Copy Managed Metadata Term Sets or Terms associated
with this content
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Supported Online Settings
Schedule

No schedule
Configure the schedule myself

Preserve the Null Column Values
Collapse Folder Structure
Folder Structure
Management

Add a column to display the source
folder path or parent folder name

Column to display the source
folder path
Column to display the parent
folder name

Data Compression
Column Mapping
Content Type Mapping
Template Mapping
Domain Mapping
User Mapping
Language Mapping
List Name Mapping
Source Deletion Method (Move
Only)

Manual
Automatic

Delete Source Checked Out Documents (Move Only)
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Supported Online Settings
Backup Environment Before
Running Plan

Backup the source environment (Move Only)

Conflict Resolution

Container level conflict
resolution

Backup the destination environment
Skip
Merge
Replace
Check lower objects
Content level conflict
resolution

Skip
Overwrite
Overwrite by Last Modified Time
Append

Apps Conflict Resolution

Skip
Update App Only
Replace App and AppData

Agent Group

Source Agent Group
Destination Agent Group

Notification
Associated Plan Group
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Supported Offline Content Manager Settings

The following table identifies the supported settings for copy jobs performed for Data Export and Data Import.

Export Settings
Refer to the following table for more information.
Export Settings

Support Status

Filter Policy
Select Source Components

Supported
Content

Include list attachment

User Profile

Supported
Supported

Data Compression

Supported

Data Encryption

Supported

Workflow

Managed Metadata Service Setting

Include workflow definition

Supported

Include workflow instance

Supported

Term

Supported

Term set

Supported

Generate Metadata File

Supported

Agent Group

Supported

Notification

Supported

Associated Plan Group

Supported
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Import Settings
Refer to the following table for more information.
Import Settings
Action

Conflict
Resolution

Attach

Supported

Merge

Supported

Preview

Supported

Container level
conflict resolution

Skip

Supported

Merge

Supported

Replace

Supported

Check lower objects
Content level conflict
resolution

Apps Conflict
Resolution

Support
Status

Supported
Skip

Supported

Overwrite

Supported

Overwrite by Last Modified Time

Supported

Append

Supported

Skip

Partially
Supported

Update App Only

Partially
Supported
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Unsupported
for SharePoint
2010
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Import Settings

Select Source
Components

Support
Status

Replace App and AppData

Partially
Supported

Configuration

Supported

Import configuration
Deselect Import
configuration

Import the
itemdependent
columns and
content types
to maintain
item integrity
Conflict
resolution for
dependent
items:

Do not
copy/move the
columns and
content types, or
the corresponding
items

Supported

Overwrite the
columns and
content types

Supported

Append the
columns and
content types to
destination

Supported

Do not import the item-dependent
columns or content types. Report
the items if the corresponding
column or content type is not
found in destination
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Import Settings
Security
Workflow

Import security

Exclude user/group without
permission

Include workflow definition
Include workflow
instance

Managed
Metadata
Service Setting

Support
Status
Supported
Supported

Include completed instance

Supported

Include
running
instance

Cancel workflows

Supported

Restart workflows

Supported

Copy Managed Metadata Term
Sets or Terms associated with
this content

Term

Supported

Term set

Supported

Preserve the Null Column Values

Supported

Folder Structure Management

Supported

Column
Mapping

Use Column Mapping

Supported

Use existing metadata file

Supported

Content Type Mapping

Supported

Template Mapping

Supported

Domain Mapping

Supported

User Mapping

Supported
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Import Settings

Support
Status

Language Mapping

Supported

List Name Mapping

Supported

Backup
Environment
Before Running
Plan

Supported

Backup the destination environment

Agent Group

Supported

Notification

Supported

Associated Plan Group

Supported
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Appendix C: Supported and Unsupported Content Manager Settings for
SharePoint Online
Refer to the following sections for more information.

Supported Online Content Manager Settings

The following table identifies the supported and unsupported Content Manager settings for SharePoint Online environments for copy
and move jobs.
*Note: Options that only exist in Move have been marked as (Move Only).
Functionality Name
Action

Source
Deletion
Method (Move
Only)

Support
Status

Attach

Supported

Merge

Supported

Preview

Supported

Manual

Supported

Automatic

Supported

Delete Source Checked Out Documents (Move Only)

Supported

Filter Policy

Supported

Select Source
Components

Configuration
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Copy/Move
configuration

Keep look and feel

Comment

Supported
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Functionality Name

Support
Status
Advanced:
Site Collection Level

Partially
Supported

Site Level
List Level
Deselect
Copy/Move
configuration

Copy/Move the
item-dependent
columns and
content types to
maintain item
integrity

Security
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Do not copy/move the
columns and content
types, or the
corresponding items

Partially
Supported

Overwrite the columns
and content types

Partially
Supported

Append the columns
and content types to
destination

Partially
Supported

Do not copy/move the item-dependent
columns or content types. Report the items if
the corresponding column or content type is
not found in destination.

Supported

Copy/Move security

Supported

Exclude user/group without permission

Partially
Supported

Comment
The content type cannot
be moved/copied when
the parent of the source
content type does not
exist in the destination
SharePoint Online site.

This setting is not
supported when the

92

Functionality Name

Support
Status

Comment
source node is from My
Registered Sites.

Content

Schedule

Include list attachment

User Profile

Supported

No schedule

Supported

Start time

Supported

Configure the schedule myself (Move
Only)

Workflow

Supported

Start time

Supported

Interval: __Days

Supported

No end date

Supported

End after__occurrences

Supported

End by__

Supported

Include workflow definition

Supported

Include workflow
instance

Include completed instance

Unsupported

Include running
instance

Cancel workflows

Unsupported

Restart workflows

Unsupported

Copy Managed
Metadata Term
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Partially
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Functionality Name
Managed
Metadata
Service Setting

Sets or Terms
Term set
associated with this
content

Support
Status
Partially
Supported

Preserve the Null Column Values

Supported

Folder Structure Management

Supported

Data Compression

Supported

Column Mapping

Supported

Content Type Mapping

Supported

Template Mapping

Supported

User Mapping

Normal User Mapping

Supported

Add a default destination user

Supported

Add a placeholder account to keep metadata even if the user no
longer exists

Unsupported

Domain Mapping

Supported

Language Mapping

Supported

List Name Mapping

Supported
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Comment

Unsupported when the
source and destination
nodes are from SharePoint
2010.
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Functionality Name

Support
Status

Backup
Environment
Before Running
Plan

Backup the source environment (Move Only)

Supported

Backup the destination environment

Supported

Rollback

Partially
Supported

Conflict
Resolution

Container Level

Skip

Supported

Merge

Supported

Replace

Supported

Check lower objects
Content Level

Apps Conflict
Resolution

For the site collection
node, Content Manager
will empty the site
collection instead of
deleting it when rolling
back in the Replace way.

Supported
Skip

Supported

Overwrite

Supported

Overwrite by Last Modified Time

Supported

Append

Unsupported

Skip

Partially
Supported

Update App Only

Unsupported
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Unsupported when
running a Content
Manager job from the
SharePoint Online node to
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Functionality Name

Support
Status

Replace App and AppData

Partially
Supported

Notification

Supported

Associated Plan Group

Supported

Create Container

Supported

Comment
a SharePoint on-premises
node.

Supported Offline Content Manager Settings

The following table identifies the supported settings for copy jobs performed for Data Export and Data Import.

Export Settings
Refer to the following table for more information.
Export Settings

Support Status

Filter Policy
Select Source Components
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Supported
Content

Include list attachment

Supported
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Export Settings
User Profile

Support Status
Supported

Data Compression

Supported

Data Encryption

Supported

Workflow

Include workflow definition

Supported

Include workflow instance

Unsupported

Managed Metadata Service Setting

Comment

Term

Partially
Supported

Term set

Partially
Supported

Generate Metadata File

Supported

Notification

Supported

Associated Plan Group

Supported

Unsupported
when the source
and destination
nodes are from
SharePoint 2010.

Import Settings
Refer to the following table for more information.
Import Settings
Action

Support Status

Attach

Supported

Merge

Supported

®
DocAve 6 Content Manager

Comment

97

Import Settings

Support Status

Preview
Conflict
Resolution

Apps
Conflict
Resolution

Container level
conflict
resolution

Supported
Skip

Supported

Merge

Supported

Replace

Supported

Check lower objects

Supported

Content level
conflict
resolution

Skip

Supported

Overwrite

Supported

Overwrite by Last Modified Time

Supported

Append

Unsupported

Skip

Partially
Supported

Update App Only

Unsupported

Replace App and AppData

Partially
Supported

Select
Configuration
Source
Components
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Import configuration
Deselect Import
configuration

Import the itemdependent
columns and

Partially
Supported
Do not copy/move
the columns and
content types, or

Partially
Supported

Unsupported for
SharePoint 2010

The content type
cannot be
moved/copied
when the parent
of the source
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Import Settings
content types to
maintain item
integrity
Conflict resolution
for dependent
items:

Security

Workflow

Import security

Include workflow definition
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Support Status
the corresponding
items
Overwrite the
columns and
content types

Partially
Supported

Append the
columns and
content types to
destination

Partially
Supported

Do not import the
item-dependent
columns or
content types.
Report the items if
the corresponding
column or content
type is not found
in destination

Supported

Exclude user/group without permission

Partially
Supported

Comment
content type
does not exist in
the destination
SharePoint
Online site.

Do not support
this setting when
the source node
is from My
Registered Sites.

Supported

99

Import Settings

Managed
Metadata
Service
Setting

Support Status

Include
workflow
instance

Include completed instance

Unsupported

Include running
instance

Cancel workflows

Unsupported

Restart workflows

Unsupported

Copy Managed
Metadata Term
Sets or Terms
associated with
this content

Term

Partially
Supported

Term set

Partially
Supported

Preserve the Null Column Values

Supported

Folder Structure Management

Supported

Column
Mapping

Use Column Mapping

Supported

Use existing metadata file

Supported

Content Type Mapping

Supported

Template Mapping

Supported

Domain Mapping

Supported

User Mapping

Partially
Supported
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Unsupported
when the source
and destination
nodes are from
SharePoint 2010.

Keeping user's
metadata is not
supported for
SharePoint
Online.
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Import Settings

Support Status

Language Mapping

Supported

List Name Mapping

Supported

Backup
Environment
Before
Running
Plan

Supported

Backup the destination environment

Notification

Supported

Associated Plan Group

Supported

®
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Comment
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Appendix D: Supported and Unsupported Elements for Content Manager
The following table lists the currently supported and unsupported elements for Content Manager.
Source
Libraries

Communications List

Tracking Lists

®
DocAve 6 Content Manager

Type

Status

Document Library

Supported

Form Library

Supported

Wiki Page Library

Supported

Picture Library

Supported

Data Connection Library

Supported

Slide Library

Supported

Report Library

Supported

Asset Library

Supported

DocAve Content Library

Partially Supported

DocAve Media Library

Partially Supported

Announcements

Supported

Contacts

Supported

Discussion Board

Supported

Links

Supported

Calendar

Supported

Comment

Unsupported for
SharePoint Online
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Source

Custom Lists

Web Pages

Workflow
*Note: Content Manager does not
support the workflow instances
associated with the checked-out
files.

®
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Type

Status

Tasks

Supported

Project Tasks

Supported

Issue Tracking

Supported

Survey

Supported

Custom List

Supported

Custom List in Datasheet View

Supported

KPI Lists (in SharePoint 2010)

Supported

Status Lists (in SharePoint 2013)

Supported

Import Spreadsheet

Supported

Basic Page

Supported

Web Part Page

Supported

sites and Workspaces

Supported

SharePoint 2010 Built-in Workflow

Partially Supported

Comment

Support both
workflow definition
and instance for
SharePoint onpremises. Support
the workflow
definition for
SharePoint Online.

103

Source

®
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Type

Status

Comment

SharePoint 2013 Built-in Workflow

Partially Supported

Support both
workflow definition
and instance for
SharePoint onpremises. Support
workflow definition
for SharePoint
Online.

SharePoint 2016 Built-in Workflow

Partially Supported

Support both
workflow definition
and instance for
SharePoint onpremises. Support
workflow definition
for SharePoint
Online.

SharePoint Designer 2010 Workflow

Partially Supported

Support both
workflow definition
and instance for
SharePoint onpremises. Only
support workflow
104

Source

Type

Status

Comment
definition for
SharePoint Online.

SharePoint Designer 2013 Workflow

Partially Supported

For SharePoint
Designer 2010
Platform Workflow:
Support both
workflow definition
and instance for
SharePoint onpremises. Support
workflow definition
for SharePoint
Online.
For SharePoint
Designer 2013
Platform Workflow:
Support the
workflow definition
for both
SharePoint onpremises and
SharePoint Online.

®
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Source

Type
SharePoint Designer 2016 Workflow

Status

Comment

Partially Supported

For SharePoint
Designer 2010
Platform Workflow:
Support both
workflow definition
and instance for
SharePoint onpremises. Support
workflow definition
for SharePoint
Online.
For SharePoint
Designer 2013
Platform Workflow:
Support the
workflow definition
for both
SharePoint onpremises and
SharePoint Online.

Nintex 2010 Workflow

®
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Partially Supported

Support for both
workflow definition
and instance for
SharePoint on-
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Source

Type

Status

Comment
premises. Only
supports workflow
definition for
SharePoint Online.

Nintex Forms

®
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Nintex 2013 Workflow

Partially Supported

Nintex 2016 Workflow

Supported

Visual Studio 2010 Workflow

Unsupported

Visual Studio 2012 Workflow

Unsupported

Visio Workflow

Unsupported

Azure Workflow

Unsupported

Nintex 2010 Forms

Partially Supported

Support for both
workflow definition
and instance for
SharePoint onpremises. Only
supports workflow
definition for
SharePoint Online.

Refer to Supported
and Unsupported
Form Controls for
Nintex Form in
SharePoint 2010.
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Source

Type

Status

Comment

Nintex 2013 Forms

Partially Supported

Refer to Supported
and Unsupported
Form Controls for
Nintex Form in
SharePoint 2013.

Nintex 2016 Forms

Partially Supported

Refer to Supported
and Unsupported
Form Controls for
Nintex Form in
SharePoint 2016
and Supported and
Unsupported Form
Controls for Nintex
Form from
SharePoint 2016 to
SharePoint Online.

RSS

Supported

Alerts

Partially Supported

Metadata

®
DocAve 6 Content Manager

Single line of text

Supported

Multiple lines of text

Supported

Choice (menu to choose from)

Supported

Unsupported when
the source nodes
are from My
Registered Sites.
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Source

Security & Properties

Version Histories

®
DocAve 6 Content Manager

Type

Status

Number

Supported

Currency

Supported

Date and Time

Supported

Look up

Supported

Yes/No

Supported

Person or Group

Supported

Hyperlink or Picture

Supported

Calculated

Supported

Business Data

Supported

Managed Metadata

Partially Supported

Version Settings

Supported

Column Settings

Supported

Permissions

Supported

Documents

Supported

Lists

Supported

Comment

Unsupported for
the SharePoint
2010 on-premises
node from My
Registered Sites.
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Source
Apps for SharePoint

User Profile

Type
SharePoint-hosted Apps

Supported

Provider-hosted Apps

Supported

Auto-hosted Apps

Supported

Colleagues

Comment

Back up

Supported

Restore

Supported

Back up

Partially Supported

Unsupported for
SharePoint Online

Restore

Partially Supported

Unsupported for
SharePoint Online

Back up

Partially Supported

Unsupported for
SharePoint Online

Restore

Partially Supported

Unsupported for
SharePoint Online

Tags/Comments Back up

Partially Supported

Unsupported for
SharePoint Online

Membership

Organization

Restore

®
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Status

Unsupported
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Source

Type
Quick Links

Site

®
DocAve 6 Content Manager

Status

Comment

Back up

Partially Supported

Unsupported for
SharePoint Online

Restore

Partially Supported

Unsupported for
SharePoint Online

Other basic
properties

Back up

Supported

Restore

Partially Supported

For SharePoint
Online sites,
properties can only
be restored when
Allow User to edit
values for this
property is set to
Yes.

Customized
properties

Back up

Partially Supported

Unsupported for
SharePoint Online

Restore

Partially Supported

Unsupported for
SharePoint Online

Create User Profile

Partially Supported

Unsupported for
SharePoint Online

Blog Site

Supported
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*Note: For detailed information on the supported and unsupported Nintex workflow actions, refer to Nintex Workflow Actions.
*Note: By default, Content Manager does not support copying or moving the Metadata Navigation setting of the SharePoint
2013/2016 site collections. However, Content Manager supports it after modifying the Content Manager configuration file. To modify
the Content Manager configuration file, complete the following steps:
1. Log into the server where DocAve Agent resides.
2. Go to the ...\AvePoint\DocAve6\Agent\data\SP2010\ContentManager directory.
3. Open the SP2010CMConfiguration.xml file using Notepad.
4. Locate the <RestoreMetadataNavigation value="false"/> node.
5. Change its value to true.
6. Save the changes and close the file.

Supported and Unsupported Form Controls for Nintex Form in SharePoint 2010

Refer to the following table for the supported and unsupported form controls for Nintex Form in SharePoint 2010:
Nintex Form

Form Control Name

Support Status

General

Border

Supported

Button

Supported

Calculated Value

Supported

Choice

Supported

Date/Time

Supported

Geolocation

Supported

®
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Nintex Form

SharePoint

®
DocAve 6 Content Manager

Form Control Name

Support Status

Comment

Hyperlink

Partially Supported

Comment 1

Image

Supported

Label

Supported

Multi Line Textbox

Supported

Page Viewer

Supported

Panel

Supported

People

Supported

Repeating Section

Supported

Rich Text

Supported

Single Line Textbox

Supported

Yes/No

Supported

Change Content Type

Supported

External Data Column

Supported

List Item

Supported

List Lookup

Supported

List View

Supported

Managed Metadata

Supported
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Nintex Form

List Columns

Form Control Name

Support Status

Comment

Workflow Diagram

Partially Supported

Comment 2

Default List Column:
Attachment

Supported

Default List Column: Name

Supported

Default List Column: Title

Supported

Custom List Column: List
Lookup

Supported

Custom List Column: Managed
Metadata

Supported

Comment 1: If the Hyperlink type column’s value of a source file is the URL of the site collection where the file resides, the migrated
URL in the destination will be unavailable.
Comment 2: The Workflow Instance ID failed to be updated in the destination after the Content Manager job.

Supported and Unsupported Form Controls for Nintex Form in SharePoint 2013

Refer to the following table for the supported and unsupported form controls for Nintex form in SharePoint 2013:
Nintex Form

Form Control Name

Support Status

General

Border

Supported

Button

Supported

Calculated Value

Supported

Choice

Supported

®
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Comment
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Nintex Form

SharePoint

®
DocAve 6 Content Manager

Form Control Name

Support Status

Date/Time

Supported

Geolocation

Supported

Hyperlink

Supported

Image

Supported

Label

Supported

Multi Line Textbox

Supported

Page Viewer

Supported

Panel

Supported

People

Supported

Repeating Section

Supported

Rich Text

Supported

Single Line Textbox

Supported

Yes/No

Supported

Change Content Type

Supported

External Data Column

Supported

List Item

Supported

List Lookup

Supported

Comment
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Nintex Form

List Columns

Form Control Name

Support Status

List View

Supported

Managed Metadata

Unsupported

Workflow Diagram

Supported

Default List Column:
Attachment

Supported

Default List Column: Name

Supported

Default List Column: Title

Supported

Custom List Column: List
Lookup

Unsupported

Custom List Column: Managed
Metadata

Supported

Comment

Supported and Unsupported Form Controls for Nintex Form in SharePoint 2016

Refer to the following table for the supported and unsupported form controls for Nintex form in SharePoint 2016:
Nintex Form

Form Control Name

Support Status

General

Border

Supported

Button

Supported

Calculated Value

Supported

®
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Nintex Form

SharePoint

®
DocAve 6 Content Manager

Form Control Name

Support Status

Choice

Supported

Date/Time

Supported

Geolocation

Supported

Hyperlink

Supported

Image

Supported

Label

Supported

Multi Line Textbox

Supported

Page Viewer

Supported

Panel

Supported

People

Supported

Repeating Section

Supported

Rich Text

Supported

Single Line Textbox

Supported

SQL Request

Supported

Web Request

Supported

Yes/No

Supported

Change Content Type

Supported

Comment
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Nintex Form

List Columns

Form Control Name

Support Status

External Data Column

Supported

List Item

Supported

List Lookup

Supported

List View

Supported

Managed Metadata

Unsupported

Workflow Diagram

Supported

Default List Column:
Attachment

Supported

Default List Column: Name

Supported

Default List Column: Title

Supported

Custom List Column: List
Lookup

Supported

Custom List Column: Managed
Metadata

Supported

Comment

Supported and Unsupported Form Controls for Nintex Form from SharePoint 2016 to SharePoint
Online
Refer to the following table for the supported and unsupported form controls for Nintex form from SharePoint 2016 to SharePoint
Online:
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Nintex Form

Form Control Name

Support Status

General

Border

Supported

Button

Supported

Calculated Value

Supported

Choice

Supported

Date/Time

Supported

Geolocation

Supported

Hyperlink

Supported

Image

Supported

Label

Supported

Multi Line Textbox

Supported

Page Viewer

Supported

Panel

Supported

People

Supported

Repeating Section

Supported

Rich Text

Supported

Single Line Textbox

Supported

SQL Request

Unsupported

®
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Nintex Form

SharePoint

List Columns

Form Control Name

Support Status

Web Request

Unsupported

Yes/No

Supported

Change Content Type

Unsupported

External Data Column

Unsupported

List Item

Unsupported

List Lookup

Supported

List View

Unsupported

Managed Metadata

Supported

Workflow Diagram

Unsupported

Default List Column: Attachment

Supported

Default List Column: Name

Supported

Default List Column: Title

Supported

Custom List Column: List Lookup

Supported

Comment

Custom List Column: Managed Metadata Supported

®
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Appendix E: Supported and Unsupported SharePoint 2013 Social Features
Social Feature

Status

My Site

Partially Supported

SkyDrive Pro (or named OneDrive for Business)

Supported

Blog

Supported

Tag

Partially Supported

Note
The head portraits of the users are
not supported.

The #Tag is stored in Managed
Metadata Service as System Term.
Unsupported for SharePoint Online

Microblog and Feed

Follow

®
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Post

Partially Supported

Reply

Partially Supported

Like

Partially Supported

Picture

Partially Supported

Link

Partially Supported

@

Partially Supported

Mentions

Partially Supported

Tag

Partially Supported

People

Supported

Site

Partially Supported

Unsupported for SharePoint Online

Unsupported for SharePoint Online
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Social Feature

Community Site

Community Portal

®
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Status

Document

Partially Supported

Tag

Unsupported

Categories

Supported

Discussion Board

Supported

Members

Supported

Badges

Supported

Reputation

Supported

Best Reply

Supported

Question

Supported

Community Setting

Supported

Note
Unsupported for SharePoint Online

Supported
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Appendix F: Content Manager Customization Support Table
The following is the customization support table of Content Manager. √ means the corresponding SharePoint object is supported to be copied or moved to the corresponding SharePoint objects.
Copy/Move To
What to
Copy/Move
Web application

Web
Application

√

®
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Site
Collection

Site List Folder

Note

Merge

What to select when copying/moving

To Web application:
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Copy/Move To
What to
Copy/Move
Site collection

Web
Application

Site
Collection

Site List Folder

√

√

√

Note

To Web application:
Merge/Attach

What to select when copying/moving

To Web application:

To site collection:
Merge/Attach

To site: Merge/Attach

To site collection:

®
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Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving

To site:

®
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Copy/Move To
What to
Copy/Move
Site

Web
Application

Site
Collection

Site List Folder

√

√

√

Note

To Web application:

What to select when copying/moving

To Web application:

Merge
To site collection:
Merge/Attach

To site: Merge/Attach

To site collection:

®
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Copy/Move To
What to
Copy/Move

Web
Application

®
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Site
Collection

Site List Folder

Note

What to select when copying/moving
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Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving

To site:

®
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Copy/Move To
What to
Copy/Move

Web
Application

List

Site
Collection

Site List Folder

√

√

Note

To site: Attach

What to select when copying/moving

To site:

To list: Merge
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Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving

To list:

Folder

√

√

To list: Attach

To list:

To folder:
Merge/Attach
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Copy/Move To
What to
Copy/Move

Web
Application

®
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Site
Collection

Site List Folder

Note

What to select when copying/moving
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Copy/Move To
What to
Copy/Move

Web
Application

Site
Collection

Site List Folder

Note

What to select when copying/moving

To folder:

®
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Copy/Move To
What to
Copy/Move

Web
Application

Item
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Site
Collection

Site List Folder

√

Note

What to select when copying/moving

Attach
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Copy/Move To
What to
Copy/Move

Web
Application

Apps

Site
Collection

Site List Folder

√

√

Note

What to select when copying/moving

To site collection:
When copying or
moving to the
destination site
collection, the Apps
are attached to the
top-level site of the
destination site
collection.
To site:
Attach

SharePoint Built-in
Workflow

√

√

√

√

If you want to copy or move the workflow, you must select the SharePoint objects that is associated with the workflow on the tree, and select the
Include workflow definition/Include workflow instance.
If the workflow in the source node is In Progress, by default the status in the destination node will be Canceled after being migrated. If you select the
Restart workflows radio button, the status in the destination node will still be In Progress after being migrated.
*Note: Content Manager does not support the workflow instances associated with the checked-out files.
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Copy/Move To
What to
Copy/Move
SharePoint
designer workflow

Web
Application

Site
Collection

Site List Folder

√

√

√

√

Note

What to select when copying/moving

Reusable workflow template is supported if the workflow has been applied in the Content Type.
Reusable workflow template without creating any workflow definition is supported.
If the workflow in the source node is In Progress, by default the status in the destination node will be Canceled after being migrated. If you select the
Restart workflows radio button, the status in the destination node will still be In Progress after being migrated.
*Note: Content Manager does not support the workflow instances associated with the checked-out files.

Nintex workflow

√

√

√

√

Reusable workflow template is only supported if the workflow has been applied in the Content Type.
Schedule in Nintex Workflow is only supported when both Include workflow definition and Include workflow instance are selected.
If the workflow in the source node is In Progress, by default the status in the destination node will be Canceled after being migrated. If you select the
Restart workflows radio button, the status in the destination node will still be In Progress after being migrated.
*Note: Content Manager does not support the workflow instances associated with the checked-out files.
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Appendix G: The Supported and Unsupported Methods
to Copy or Move Sites of Different SharePoint
Experience Versions
Refer to the following table for the information of the SharePoint experience versions that are
supported by Content Manager:
•

Source Experience Version – The experience version of the source node.

•

Destination Experience Version – The experience version of the destination
node.

•

Supported Status – Whether or not Content Manager supports to copy or move
from the source SharePoint nodes to the destination SharePoint nodes.

Source Experience Version

Destination Experience Version

Supported Status

SharePoint 2010 on-premises

SharePoint 2010 on-premises

Supported

SharePoint 2013 on-premises with
2010 experience version

SharePoint 2013 on-premises with
2010 experience version

Supported

SharePoint 2013 on-premises with
2010 experience version

SharePoint 2013 on-premises with
2013 experience version

Partially supported

SharePoint 2013 on-premises with
2010 experience version

SharePoint Online

Supported

SharePoint 2013 on-premises with
2013 experience version

SharePoint 2013 on-premises with
2010 experience version

Unsupported

SharePoint 2013 on-premises with
2013 experience version

SharePoint 2013 on-premises with
2013 experience version

Supported

SharePoint 2013 on-premises with
2013 experience version

SharePoint 2013 Online

Supported

SharePoint Online

SharePoint 2013 on-premises with
2010 experience version

Unsupported
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Source Experience Version

Destination Experience Version

Supported Status

SharePoint Online

SharePoint 2013 on-premises with
2013 experience version

Supported

SharePoint Online

SharePoint Online

Supported

SharePoint 2016 on-premises

SharePoint 2016 on-premises

Supported

SharePoint 2016 on-premises

SharePoint Online

Supported

SharePoint Online

SharePoint 2016 on-premises

Supported.

Unsupported SharePoint Elements for Partially Supported Methods
Refer to the following sections about the unsupported SharePoint elements for partially
supported methods and the solutions for these unsupported SharePoint elements.

Master Page
The master pages in the SharePoint 2010 are different from those in the SharePoint 2013. When
copying or moving the master pages from the source to the destination, the destination master
pages will use the destination SharePoint experience version, and the master page gallery and
the settings will be skipped.

Site Template
Some of the site templates in the SharePoint 2010 are not compatible with those in the
SharePoint 2013. Refer to the table below for the supported and unsupported site templates
when copying or moving the source node to destination node with a different SharePoint
experience version.
•

ID – The ID of the site template.

•

Name – The name of the site template.

•

Title – The title of the site template.

•

Supported Status – Whether or not the site template is supported by Content
Manager.

ID

Name

Title

Supported
Status

0

GLOBAL#0

Global template

Supported

1

STS#0

Team Site

Supported
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ID

Name

Title

Supported
Status

1

STS#1

Blank Site

Supported

1

STS#2

Document Workspace

Supported

2

MPS#0

Basic Meeting Workspace

Supported

2

MPS#1

Blank Meeting Workspace

Supported

2

MPS#2

Decision Meeting Workspace

Supported

2

MPS#3

Social Meeting Workspace

Supported

2

MPS#4

Multipage Meeting Workspace

Supported

3

CENTRALADMIN#0

Central Admin Site

Supported

4

WIKI#0

Wiki Site

Supported

9

BLOG#0

Blog

Supported

15

SGS#0

Group Work Site

Supported

16

TENANTADMIN#0

Tenant Admin Site

Supported

2764

ACCSRV#0

Access Services Site

Supported

N/A

ACCSRV#1

Assets Web Database

Unsupported

N/A

ACCSRV#3

Charitable Contributions Web
Database

Unsupported

N/A

ACCSRV#4

Contacts Web Database

Unsupported

N/A

ACCSRV#5

Projects Web Database

Unsupported

N/A

ACCSRV#6

Issues Web Database

Unsupported

7

BDR#0

Document Center

Supported

14483

OFFILE#0

(obsolete) Records Center

Supported

14483

OFFILE#1

Records Center

Supported

40

OSRV#0

Shared Services Administration
Site

Supported

3100

PPSMASite#0

PerformancePoint

Supported
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ID

Name

Title

Supported
Status

3200

BICenterSite#0

Business Intelligence Center

Supported

20

SPS#0

SharePoint Portal Server Site

Supported

21

SPSPERS#0

SharePoint Portal Server
Personal Space

Supported

22

SPSMSITE#0

Personalization Site

Supported

30

SPSTOC#0

Contents area Template

Supported

31

SPSTOPIC#0

Topic area template

Supported

32

SPSNEWS#0

News Site

Supported

39

CMSPUBLISHING#0

Publishing Site

Supported

53

BLANKINTERNET#0

Publishing Site

Supported

53

BLANKINTERNET#1

Press Releases Site

Supported

53

BLANKINTERNET#2

Publishing Site with Workflow

Supported

33

SPSNHOME#0

News Site

Supported

34

SPSSITES#0

Site Directory

Supported

36

SPSCOMMU#0

Community area template

Supported

38

SPSREPORTCENTER#0

Report Center

Supported

47

SPSPORTAL#0

Collaboration Portal

Supported

50

SRCHCEN#0

Enterprise Search Center

Supported

51

PROFILES#0

Profiles

Supported

52

BLANKINTERNETCONTAINER#0 Publishing Portal

Supported

54

SPSMSITEHOST#0

My Site Host

Supported

56

ENTERWIKI#0

Enterprise Wiki

Supported

90

SRCHCENTERLITE#0

Basic Search Center

Supported

90

SRCHCENTERLITE#1

Basic Search Center

Supported
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ID

Name

N/A

Title

SRCHCENTERFAST#0

Supported
Status

FAST Search Center

Unsupported

List Template
All the list templates can be copied or moved to the destination.
*Note: Both the shared documents library and the document library (which is created
automatically after activating the SharePoint Server Publishing Infrastructure feature in the
SharePoint 2010 site collection) will be copied or moved to the destination documents library in
SharePoint 2013 mode site.

Theme
When copying or moving the themes from the source to the destination, the destination themes
will use the destination SharePoint experience version, and the theme gallery and the settings
will be skipped.

Web Part
Refer to the table below for the supported and unsupported Web parts when copying or
moving the source node to destination node with a different SharePoint experience version. The
unsupported Web parts will be skipped.
•

Type – The type of the Web part.

•

Title – The title of the Web part.

Type
Business Data

Title

SharePoin
t 2010

SharePoin
t 2013

Business Data Actions

Y

Y

Business Data Connectivity Filter

Y

Y

Business Data Item

Y

N

Business Data Item Builder

Y

Y

Business Data List

Y

Y

Business Data Related List

Y

Y

Chart Web Part

Y

N

Excel Web Access

Y

Y

®
DocAve 6 Content Manager

140

Type

Content Rollup

Filters

Forms

Title

SharePoin
t 2010

SharePoin
t 2013

Indicator Details

Y

Y

Status List

Y

Y

Visio Web Access

Y

Y

Categories

Y

Y

Content Query

Y

Y

Relevant Documents

Y

Y

RSS Viewer

Y

Y

Site Aggregator

Y

Y

Sites in Category

Y

Y

Summary Links

Y

N

Table Of Contents

Y

N

Web Analytics Web Part

Y

N

WSRP Viewer

Y

Y

XML Viewer

Y

Y

Apply Filters Button

Y

Y

Choice Filter

Y

Y

Current User Filter

Y

Y

Date Filter

Y

Y

Page Filed Filter

Y

N

Query String (URL) Filter

Y

Y

SharePoint List Filter

Y

Y

SQL Server Analysis Service Filter

Y

N

Text Filter

Y

Y

HTML Form Web Part

Y

Y
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Type

Media and Content

Outlook Web App

Search

Title

SharePoin
t 2010

SharePoin
t 2013

InfoPath Form Web Part

Y

Y

Content Editor

Y

Y

Image Viewer

Y

Y

Media Web Part

Y

Y

Page Viewer

Y

Y

Picture Library Slideshow Web Part

Y

Y

Silverlight Web Part

Y

Y

My Calendar

Y

N

My contacts

Y

N

My Inbox

Y

N

My Mail Folder

Y

N

My Tasks

Y

N

Advanced Search Box

Y

N

Dual Chinese Search

Y

N

Federated Results

Y

N

People Refinement Panel

Y

N

People Search Box

Y

N

People Search Core Results

Y

N

Refinement Panel

Y

N

Related Queries

Y

N

Search Action Links

Y

N

Search Best Bets

Y

N

Search Box

Y

Y

Search Core Results

Y

N
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Type

Social
Collaboration

SQL Server
Reporting

Title

SharePoin
t 2010

SharePoin
t 2013

Search Paging

Y

N

Search Statistics

Y

N

Search Summary

Y

N

Search Visual Best Bet

Y

N

Top Federated Results

Y

N

Contact Details

Y

Y

Note Board

Y

Y

Organization Browser

Y

N

Site Users

Y

Y

Tag Cloud

Y

Y

User Tasks

Y

Y

SQL Server Reporting Services Report
Viewer

Y

N
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Notices and Copyright Information
Notice
The materials contained in this publication are owned or provided by AvePoint, Inc. and are the property
of AvePoint or its licensors, and are protected by copyright, trademark and other intellectual property
laws. No trademark or copyright notice in this publication may be removed or altered in any way.
Copyright
Copyright ©2012-2018 AvePoint, Inc. All rights reserved. All materials contained in this publication are
protected by United States and international copyright laws and no part of this publication may be
reproduced, modified, displayed, stored in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording or otherwise, without the prior written consent of
AvePoint, 525 Washington Blvd, Suite 1400, Jersey City, NJ 07310, USA or, in the case of materials in this
publication owned by third parties, without such third party’s consent. Notwithstanding the foregoing, to
the extent any AvePoint material in this publication is reproduced or modified in any way (including
derivative works and transformative works), by you or on your behalf, then such reproduced or modified
materials shall be automatically assigned to AvePoint without any further act and you agree on behalf of
yourself and your successors, assigns, heirs, beneficiaries, and executors, to promptly do all things and
sign all documents to confirm the transfer of such reproduced or modified materials to AvePoint.
Trademarks
AvePoint®, DocAve®, the AvePoint logo, and the AvePoint Pyramid logo are registered trademarks of
AvePoint, Inc. with the United States Patent and Trademark Office. These registered trademarks, along
with all other trademarks of AvePoint used in this publication are the exclusive property of AvePoint and
may not be used without prior written consent.
Microsoft, MS-DOS, Internet Explorer, Office, Office 365, SharePoint, Windows PowerShell, SQL Server,
Outlook, Windows Server, Active Directory, and Dynamics CRM 2013 are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.
Adobe Acrobat and Acrobat Reader are trademarks of Adobe Systems, Inc.
All other trademarks contained in this publication are the property of their respective owners and may not
be used without such party’s consent.
Changes
The material in this publication is for information purposes only and is subject to change without notice.
While reasonable efforts have been made in the preparation of this publication to ensure its accuracy,
AvePoint makes no representation or warranty, expressed or implied, as to its completeness, accuracy, or
suitability, and assumes no liability resulting from errors or omissions in this publication or from the use of
the information contained herein. AvePoint reserves the right to make changes in the Graphical User
Interface of the AvePoint software without reservation and without notification to its users.
AvePoint, Inc.
525 Washington Blvd
Suite 1400
Jersey City, NJ 07310
USA
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